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Congratulations on purchasing ReachOut!

You now have the fastest complete remote access solution for use with
Windows & DOS. With ReachOut, you can link two computers so you can
access one from the other. These computers can be in the same room or
on opposite sides of the world—with ReachOut, it doesn’t matter.

Modem and Network Support

Whether you use ReachOut in Windows  or in DOS , you can
connect with a modem or over a network and operate a distant
computer just as if you were sitting in front of it.

ReachOut’s Capabilities

ReachOut comes with many features that make remote computing both
powerful and easy to use. Here are just some of the things you can do:

� Run applications remotely, making the connected computer’s
programs appear on your desktop

� Move or copy files quickly and reliably between computers

� Synchronize directories; bring them up to date with a single click

� Access another computer’s drives as if they were your own

� Print your work at either connected computer

� Type messages that appear instantaneously at the other computer

� Connect to any modem system using ReachOut’s terminal emulator

� Automate ReachOut for unattended operation with a powerful
scripting language
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WorldWide Remote Access

When you are away from your home or office computer, ReachOut lets
you work just as if you were there. You can access and control the
computer, even your network drives. You can edit documents, check
your e-mail, run programs, update spreadsheets and databases, transfer
files, and share resources.

ReachOut gives you everything you need. Here are just a few of the ways
ReachOut can make you more effective.

To solve this
problem ...

Use this ReachOut solution ...

People send you e-mail and add
to your online schedule in the
evening, but you don’t know
about the e-mail or schedule
changes until you get to the office
in the morning.

Connect to the office computer
before you leave home. Check
your schedule and mail so you can
be prepared for the day’s events.

You travel a great deal and create
database files on your laptop
computer. You have to update the
central database every day.

Connect to the central database
and update the database from your
traveling keyboard.

You find the expense of phone
calls on the road a burden. And
you don’t want to wait around
until the phone rates are lower.

Depend on ReachOut’s callback
feature. The Host computer will
return the call and be billed it.

Your office uses Lotus Notes™ for
sharing information. When you
post information files from other
locations, you don’t have to
transfer them first.

Use ReachOut’s Drive Mapping to
post files from where you are to
the Lotus Notes server on a remote
system.
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Using ReachOut for Windows & DOS

ReachOut for Windows and DOS lets you install and use ReachOut from
the DOS prompt or under Windows 3.1 or higher. If you have Windows
95 installed, you’ll most likely prefer to use ReachOut for Windows 95.

When you use ReachOut for Windows & DOS under Windows 3.1,
Windows 95, or DOS you can control another ReachOut computer that
uses DOS, Windows, or even Windows 95.

ReachOut Communications

ReachOut communicates using any of several different connection types.

For this
type ...

Both computers
must ...

ReachOut
supports ...

Modem Have access to a
modem and a
telephone line.

Most modems, including
ISDN and cellular–or define
your own. Also supports
modem pools, such as
NASI/NCSI or NetWare
Connect.

Network Run on the same
network.

Popular LANs and WANs,
including NetWare, Banyan
VINES, WinSock, FTP’s
TCP/IP, and NetBIOS
compatible networks.

Direct Cable Be connected through
serial ports.

Standard null modem cable.
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ReachOut Configuration

If you install ReachOut for more than one connection type, you can
switch between them. For example, if you use Windows for Workgroups
at the office, you may use ReachOut configured for a NetBIOS
compatible system over the network. To control your computer at home,
however, you’ll use a modem.

Chapter 7, Configuration, and the ReachOut Help include full details on
configuring ReachOut.

Typical ReachOut Session

Here’s how you might put ReachOut to work for you. Suppose you are
going across town to discuss a new project with a colleague. You are
expecting some important e-mail about the project, so you’ll want to
check in with your computer during the meeting.

Before leaving, you start ReachOut Host, so it is waiting for a
ReachOut connection.

While at your colleague’s office, start ReachOut Viewer on the
local computer and click Remote Control to connect to the
waiting computer on your desk.

Your office computer’s desktop appears on the Viewer computer.

Check your e-mail. Several files that
could be useful in your discussion are
attached.
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Share the information with your colleagues. They need a copy of a file
referred to in the e-mail.

In the ReachOut Viewer window, click File Transfer and
copy the files from your computer directly onto your
colleague’s hard disk.

Disconnect the ReachOut session. It’s time for lunch.

ReachOut Terminology

Each ReachOut connection involves two computers: Viewer and Host.

The ReachOut Viewer computer initiates the ReachOut connection. A
user at the ReachOut Viewer can control the connected computer and
transfer files with ReachOut File Manager. The Viewer user sees an image
of the desktop of the connected Host computer.

The ReachOut Host computer waits for a Viewer to connect. The
ReachOut Host need not have a user during the session, because the
Viewer controls this computer.

In ReachOut Drive Mapping, a computer makes some or all of its drives
available to the connected computer. Drives or directories on one
computer are mapped to drive letters on the other. The Server computer
makes drives available; it offers files for access. The computer that gains
access to the served drives is called the Client. Chapter 6 shows how to
use Drive Mapping in a ReachOut session.

The terms local and remote are often applied to various ReachOut
components. In this User’s Guide, we use them only in relationship to
the user. The Viewer PC always has a user, so it is convenient to consider
the ReachOut Viewer as the local computer and the ReachOut Host as
the remote computer. However, if you are a user at a Host PC, that is
your local computer. In this User’s Guide, we use local and remote only
in situations where the reference is clear.
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New in ReachOut for Windows & DOS
Our many users have told us what they want in a complete remote access
product. This table lists new or enhanced features.

Feature What it does for you

LZS™ Compression Lets you accomplish more work in less time,
and slash connect costs while you are at it.

More Connection
Types

Now supports even more, including WinSock
(TCP/IP) for easy use over the Internet.
Supports many more high speed, ISDN, and
cellular modems, and is optimized for remote
node. And you get it all in one package.

SmartSend™ Reduces file transfer time by up to 90% by
sending only the changed parts of files.

RapidSync™ Updates files and directories automatically. No
more searching for the latest version.

Security
Enhancements

Protects your computer and data with new
security enhancements. You can create a unique
security profile for each user.

Windows
Compatibility

Uses Windows DLLs instead of TSRs to give
100% compatibility. Use it with Windows 3.1,
Windows for Workgroups, and Windows 95.

Windows 95 Features Lets you access a computer running Windows
95 from your Windows 3.1 system. You can also
use it on a Windows 95 system, but ReachOut
for Windows 95 is a better choice.

Scripting to Automate
ReachOut

Lets you schedule ReachOut sessions to run at
your convenience.

Integrated Help Context-sensitive help gives you access to as
much as you need, when you need it.
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Using ReachOut Documentation

We provided several ways you can find the information you need.

Use this ... For this ...

User’s Guide To get up and running; to learn the basic
features of all ReachOut components

ReachOut Help Full reference information on all dialogs,
commands, and functions, along with tips and
procedures

Documents for easy
printing

Easy printing of full information on using the
terminal emulator and automating ReachOut
with scripting

User’s Guide

The manual provides all the information most people need to get started
and use ReachOut. Most of the information applies to both ReachOut for
Windows and ReachOut for DOS. Even specific procedures are very
similar, because we use a graphical interface with menus for the DOS
Viewer and Host applications.

ReachOut for DOS

Wherever ReachOut in DOS is significantly different, you’ll see shaded
information like this about the equivalent DOS procedure.
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Chapter ... Shows you ...

1  Overview What ReachOut includes.

2  Installation How to install ReachOut.

3  Getting Connected How to set up a Host and Viewer, then
connect them over a modem, a
network, or a direct connect cable.

4  Remote Control How to control the connected
computer, including Chat, panning,
scaling, and printing.

5  File Manager How to transfer files and synchronize
directories.

6  Drive Mapping How to use one computer’s drives as if
they were on the other computer.

7  Configuration How to change your setup or switch
between different connection types.

8  Security How to use ReachOut’s security to
ensure that your data is safe.

9  Network Operation How to set up and administer
ReachOut in a network environment.

Appendix A Troubleshooting How to solve problems with ReachOut.

Appendix B Technical Notes Reference information, including how
ReachOut changed your system, along
with installation scripts, command line
parameters, drive map automation and
special DOS considerations.

Appendix C Windows 95 Using ReachOut for Windows & DOS
with Windows 95.
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ReachOut Help

We provide you with help from any dialog or message box. You’ll get full
information on all the fields and buttons, as well as general information
about ReachOut’s capabilities.

The Windows help includes Tips, Troubleshooting, and How To
information in all areas, along with full reference information about:

• Using the ReachOut terminal emulator

• Automating installation, especially for installing over a network

• Automating ReachOut sessions with a full scripting language

• Command line parameters you can use to tailor your icons and
commands

Reference Documents

Because this information is in the Windows ReachOut Help but not in
print form, we included additional documents on disk that you can print
at your convenience.

• TERMEM.TXT is the Terminal Emulator Reference. Use any text
editor or word processor to print it.

• AUTOMATE.WRI is the Automating ReachOut Scripting Reference.
Use Windows Write to print it.
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When you use ReachOut, you will be accessing one computer from
another. For ReachOut to make the connection between the computers,
you must install ReachOut on both computers. Your copy of ReachOut
comes with a license for up to two installations.

This chapter covers the installation process in Windows and in DOS. If
you want full ReachOut capabilities for both environments, you should
install under Windows.

Before you install or attempt to use ReachOut, check Preparing for the
Installation in this chapter to make sure you have all the equipment
and information you need. During the installation process, you can click
any Help button for immediate context-sensitive help with ReachOut’s
SetupPilot™.

Chapter 7, Configuration, tells you how to change any settings after
ReachOut is installed.
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Preparing for the Installation

Here are a few things you should do ahead of time to make the
installation go smoothly:

� If you have any other remote control software on your computer,
remove it before you install ReachOut.

� If you will use ReachOut with a modem, be sure the modem is
installed properly. You need to know the type of modem you have
(brand name and model number), what communication port it is
connected to on your computer (usually COM1 or COM2), and its
transmission speed (such as 9600, 14400, or 28800 baud). Be
sure the modem is plugged into a telephone jack. If you will use an
ISDN modem, make sure it is plugged into an ISDN line.

� If you will use ReachOut over a network, you need to know the type
of network you have, such as NetWare or NetBIOS. If you will use
ReachOut after connecting with remote node software, know which
network as well.

� If your computer is directly connected to the other computer with a
null modem cable, you need to know which communication port is
used on each computer (usually COM1 or COM2).

� If you are sharing a modem on the network, you need to know the
type of the Modem Pool software used. ReachOut supports software
compatible with Telebit ACS, NASI/NCSI, NetWare Connect, INT 14h,
and Modem Assist Plus. If you need help figuring out which one of
these to use, ask your system administrator.

Get as much information as you can about your modem or network
before you continue with the installation. If you have any questions
during the installation, click the Help button.
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Installing ReachOut

Your standard copy of ReachOut comes with a license for you to use it
on two computers. If you access a computer from several locations, you
can install ReachOut on all the calling computers.

Chapter 9, Network Operation, explains why you might need to install
ReachOut from a network. Each user who installs ReachOut from the
network must have a valid ReachOut license. If you are installing
ReachOut from a network drive, ask your ReachOut supervisor where to
find the setup files on the network.

Install ReachOut directly from the CD-ROM. If one of your computers
doesn’t have a CD-ROM drive, you may have access to a computer that
does. Just load the CD-ROM and examine its folder structure. You can
either copy the entire hierarchy to a network drive or create a set of
floppy disks for use in installing ReachOut.

To install from CD-ROM or floppy disks

1. Insert the CD-ROM or Disk 1 into the drive.

2. Choose Run from Program Manager’s File menu.

3. In the text box, type D:\SETUP.EXE and click OK. (In this

example, D: represents your CD-ROM drive letter).

 Note:  To install ReachOut from the network, follow the above
procedures. For step 3, type the full path to the files on the
network.

4. Follow the instructions on your screen.

5. Repeat these instructions to install ReachOut on your

other computer.

Personalizing ReachOut

When you personalize ReachOut, you must enter your serial number;
you’ll  find  it  on  the  back  of  your  CD-ROM  case.   ReachOut
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displays the serial number when you choose About from the Help menu
in either the Host or Viewer. You can access it at any time.

Complete or Custom Installation

ReachOut lets you choose the type of installation: Complete or Custom.

Choose Complete if you plan to use your computer as a Host and Viewer
and if you want to be able to work under DOS as well. A Complete
installation lets you use ReachOut with any supported form of modem or
network. You can reconfigure ReachOut to use a different connection
type after it is installed.

Choose Custom if you plan to use your computer only as Host or Viewer,
only in or out of Windows, or if you don’t have to use ReachOut over all
the available connection types.

A Custom installation can save space in memory as well as on your hard
disk.
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Tailoring ReachOut

If you are upgrading from an earlier version of ReachOut, ReachOut
uses information you used before, including the computer name, the
passwords, and any connection information. But if this is your first
ReachOut installation, you’ll have to supply a computer name, as well as
at least one user name and password for use when this computer is a
ReachOut Host. You can change these values at any time.

To install ReachOut from DOS

1. Insert the CD-ROM or Disk 1 in the appropriate drive.

2. At the DOS prompt, type D:\SETUPDOS and press ENTER.

(In this example, D: represents your CD-ROM drive.)

3. Follow the on-screen instructions to complete the

installation.

ReachOut for Windows

The installation program creates the ReachOut group in Program
Manager. The icons in the group depend on the type of installation. If
you chose Complete, the program group looks like this:

Once ReachOut is installed, you are ready to connect to other
computers. Chapter 3, Getting Connected, has details.
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Use this icon …… To ……
Start the Host and prepare your computer
to be controlled by another computer. For
details, see Chapter 3, Getting Connected.

Start the Viewer and connect to another
computer. For details, see Chapter 3,
Getting Connected.

Change your ReachOut configuration,
including from modem to network. For
details, see Chapter 7, Configuration.
Control or change supervisor level security.
For details, see Chapter 9, Network
Operation.

Protect your computer against unauthorized
access. For details, see Chapter 8, Security.

Create or run scripts for automating
ReachOut sessions. For details, see the
Automating topic in ReachOut Help.

Get ReachOut Help. Double-click this icon
to open the main contents page.

Remove ReachOut from your computer.

Find out who to contact for technical
support.

Appendix B explains any changes ReachOut may have made to your
system. It also shows how you can use many of the files placed in your
ReachOut directory.



ReachOut for Windows & DOS

17

ReachOut for DOS

If you will be using ReachOut from DOS and expect to use a mouse, be
sure the mouse driver is loaded in the CONFIG.SYS or AUTOEXEC.BAT
file. In order to be active when you are connected, the mouse driver
must be loaded before ReachOut is. You’ll even be able to control a
Windows session on a Host computer from DOS.

To use ReachOut in DOS, start the DOS Viewer or DOS Host at the DOS
prompt. ReachOut uses the current connection type.

HOST Lets a ReachOut Viewer connect to your computer

VIEW Lets you connect to a ReachOut Host or other
computer

UNLOADMH Removes ReachOut modem drivers from memory

UNLOADNH Removes ReachOut network drivers from memory

For details on how to start ReachOut in DOS, see Chapter 3, Getting
Connected.

Register Today

Don’t forget to register your copy of ReachOut. We want to ensure that
you get the support you need. We’ll also make sure you receive
information about new products, product upgrades, and more.

Fill out the registration card from your package, and send it in today.



Chapter 2 •• Installation

18



You have installed ReachOut. Now you are ready to use it.

A ReachOut connection requires two computers configured for the same
connection type; both must be on the same network, configured to use a
modem, or directly cabled together. ReachOut can also use a modem to
connect a computer to an online service such as CompuServe or a
bulletin board system.

In this chapter, we assume you are using a modem and connecting from
Windows. But don’t worry if you use another connection type or connect
from DOS. The steps are similar, although the exact words you see on
the screen may not be. For any ReachOut connection you’ll have to:

� Start the Host on one computer

� Start the Viewer on another

� Connect the two computers

Once you are connected, you’ll be able to switch between Remote
Control, File Manager, and Chat. Chapters 4 and 5 cover details of using
these functions.

Where necessary, we’ll provide additional information for connecting on
a network, from DOS, or through ReachOut’s terminal emulator.
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The ReachOut Connection

A ReachOut connection involves a Host computer that is controlled by a
Viewer computer. Normally, the Host computer waits for the Viewer to
connect. To reverse telephone charges or for security reasons, the Host
can call the Viewer back to complete the connection.

In most cases, you sit at the Viewer computer. From the Viewer, you can
view and control the Host completely, use the ReachOut File Manager to
transfer or manage files on either computer, or Chat with a user at the
Host.

Types of Connections

Both computers in a ReachOut connection must use the same
connection type; they must both use a modem, for example, or they must
be on the same network. ReachOut can establish several different types
of connections, no matter what the means of communications.

� Viewer in Windows controls a Host in Windows

� Viewer in Windows controls a Host in DOS

� Viewer in DOS controls a Host in Windows

� Viewer in DOS controls a Host in DOS

If you did a complete ReachOut for Windows installation, your computer
can be a Viewer or a Host under either Windows or DOS. It can even
start controlling a computer in DOS or Windows and switch to the other
operating environment during the ReachOut session.

Note: If you want to control another computer from DOS, you may
encounter some resolution limitations. While you can control a
Windows session on another computer, you won’t be able to use a video
resolution higher than one set for the Viewer computer. See Appendix A,
Troubleshooting, for additional video resolution information.
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Getting Ready

Before establishing a ReachOut connection, be sure your system is
ready. During Install, you configured ReachOut for one connection type.
If you want to provide additional information about that connection type
or change to a different connection type, you’ll have to configure
ReachOut, as shown in Chapter 7, Configuration.

� To connect over telephone lines using a modem, you need a phone
line and attached modem on both Host and Viewer.

� To connect directly, you need a null modem cable attached to the
configured COM port on each computer.

� To connect over a network, both Host and Viewer must be running
on the network. The users need not be logged on, however.

� To connect over the Internet, connect to the Internet before starting
ReachOut if you use a modem for Internet access.

Starting the ReachOut Host

The ReachOut Host computer must be ready and waiting so that it can
respond when a Viewer calls. Whenever the Host is running, whether
open or minimized, a Viewer can connect to it.

To start the Host

1. Go to the computer that is to be controlled.

 If ReachOut Host is in the StartUp group, it will be open

or minimized. In either case, the Host is ready.

2. Double-click ReachOut Host in the ReachOut program

group.

Tip! If you want the computer to be waiting for a connection every
time you start Windows, you can ask ReachOut to put it in your
StartUp group. Chapter 7, Configuration, explains how.
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The Host buttons make it easy to perform several ReachOut operations.

To do this ... Choose this ...

Connect to a waiting Viewer,
which can control this Host  or 

Exchange messages with the
connected computer user

Add or change passwords that
Viewers can use to connect to
this computer

Change drive mappings. Active
only when connected and
mapped drives are available.

      (replaces Edit
           Passwords)

Close the Host

Get information about ReachOut

End the connection
      (replaces Connect)
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Note: During a new installation, you supplied at least one password.
You can change the information by clicking the Edit Passwords button.
For other security features, pull down the Security menu and choose
Options. The ReachOut Help and Chapter 8, Security, include full details.

The ReachOut Host menu items let you control many ReachOut features.
Chapter 4, Remote Control, covers what you can do from the Host
during a ReachOut session. ReachOut Help provides detailed
information on each menu and command.

ReachOut for DOS

To start the Host under DOS, change to the ReachOut directory and type
the command HOST. Then press ENTER. ReachOut is loaded into memory
for the current connection type. (Messages on the screen tell you how to
see the screen.) Just press ALT+RIGHTSHIFT on the Host keyboard to see
the Host screen, no matter what application is running.

The Security menu lets you change passwords and other security
features. The Link menu contains commands for connecting to a Viewer
from the Host.

Starting the ReachOut Viewer

The ReachOut Viewer connects to a waiting ReachOut Host to make the
ReachOut connection.

To start the ReachOut for Windows Viewer

1. Go to the computer that you will be connecting from.

2. Double-click ReachOut Viewer in the ReachOut program

group.
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The ReachOut Viewer buttons make it easy to use ReachOut.

To do this ... Choose this ...

Connect to a waiting Host
 or  or 

Control a Host computer

Transfer files or
synchronize directories

Exchange messages with
another computer user

Start ReachOut’s terminal
emulator

Change drive mappings.
Active only when
connected and mapped
drives are available

 (replaces Terminal
       Emulator)

Close the Viewer
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To do this ... Choose this ...

Get information about
ReachOut

End the connection
 (replaces Exit)

The menu items let you connect (link), as well as use many ReachOut
features that are covered in Chapter 4, Remote Control, and Chapter 5,
File Manager. ReachOut Help provides detailed information on each
menu and command.

ReachOut for DOS

To use the ReachOut Viewer under DOS, change to the ReachOut
directory. Then type VIEW and press ENTER to load the Viewer into
memory. You’ll see the DOS ReachOut Viewer screen. You can change
connection settings or modify Viewer preferences if you like.

Making the ReachOut Connection

When the ReachOut Viewer is open, you are ready to connect to a
waiting Host computer that is configured for the same type of
connection. Both computers must use a modem or the same network,
or be directly cabled together.

In most cases, you know what you want to do with ReachOut. You might
want to use Remote Control to run the other computer, use ReachOut
File Manager to transfer files, or use Chat to converse with the Host user.
For these situations, just choose the appropriate button to connect. In
some cases, you might want to use some other functions, such as Drive
Mapping or connecting to a BBS. In these cases, choose Connect Only
from the Link menu.
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If you are not already connected when you choose what you want to do,
ReachOut presents a listing in a phone book format. The screen also
includes a field where you can type the phone number or network name
of the system you want. Once it connects, you’ll be able to perform the
function you chose or choose a different one.

Note: The Connect window displays existing entries in a phone book
format. To add an entry, click the Add button. ReachOut Help and
Chapter 4, Remote Control, cover managing the phone book in detail.

To connect from Windows

1. Start ReachOut Viewer, if necessary.

2. Click the Remote Control, File Transfer, or Chat button.

 If you prefer, you can choose Connect Only from the Link

menu. If you are configured for direct connect cable, the

computers connect immediately. Once you are

connected, use LEFTSHIFT+RIGHTSHIFT to bring up the

Viewer and choose a ReachOut function.

3. Tell ReachOut where the Host is.

� Modem: select entry or type the Host’s phone number.

� Network: select entry or type the Host’s network name.

4. Choose OK.

5. If asked, enter the Host’s user name and password, then

choose OK.

Note: The Host system may require callbacks. Callbacks required for
security always call back the Viewer at a prespecified number.
Callbacks used for other reasons, such as to reverse telephone charges,
may ask you to enter the telephone number. After ReachOut establishes
the initial connection, the Host prompts for a return call number, if
necessary, then disconnects and calls the Viewer. When the Viewer
responds, the ReachOut session can begin.
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ReachOut for DOS

In most cases, you’ll use the ReachOut phone book. Use Edit Phone
Book on the Preferences menu to add entries. You can type the phone
number or network name if you choose Connect to Host PC from the
Link menu to make the connection.

To connect from DOS

1. Choose the mode to use after you are connected.

 To do this, choose Once Connected from the Link menu.

From the submenu, choose Take Control of Host, Invoke

File Manager, Chat with Host User, or Exit to DOS.

2. Choose how to connect from the Link menu.

3. Choose the name from the list or type it in the field.

4. If asked, enter the Host’s user name and password.

Successful ReachOut Connection

When ReachOut connects, you are ready to control the Host. What you
see depends on how you made the connection. ReachOut Help is
available from the Host or Viewer.

Connection Effect

Connect Only
(from the Link
menu)

You still see your own desktop. ReachOut’s status
is Connected. You can use Drive Mapping,
Remote Control, File Transfer, or Chat.

The viewing window is active. The Host
appearance depends on whether you are in
Windows or DOS and the relative size and
resolution of the Viewer and Host displays. See
Chapter 4, Remote Control, for details.
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Connection Effect

Host and Viewer can exchange messages. See
Chapter 4, Remote Control, for details.

File Manager is active so you can transfer files
or synchronize directories. You can use drives
and directories on the Viewer and the Host. To
control File Manager access, use Options on the
Host’s Security menu when not connected. See
Chapter 5, File Manager, for details.

Suppose you are using ReachOut File Transfer and want to control the
Host computer. Or you are controlling the Host and want to use File
Manager to synchronize directories on both computers. You can change
from one ReachOut function to another easily.

To change the ReachOut function

1. Bring up the ReachOut Viewer window.

• Choose ReachOut Viewer from the control menu.

• Press LEFTSHIFT+RIGHTSHIFT.

• Double-click the Host icon in the Viewing window.

This brings up ReachOut Viewer on the local screen.

2. Click Remote Control, File Transfer, or Chat.

While controlling a Host computer, you may want to use your local
computer. Here are several ways to transfer control:

• If you can, click anywhere outside the viewing window.

• Press CTRL+ESC. This brings up the local computer’s task list so you
can choose a task from the local computer.
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ReachOut for DOS

In DOS, press LEFTSHIFT+RIGHTSHIFT to bring up the Viewer. Choose Chat
from the menu bar, or choose Invoke File Manager to transfer files or
Exit to Host PC to control the Host. Exit to Viewer PC lets you get back to
the local environment.

To return to controlling the Host, close the File Manager or Chat
window. If you have exited to the Viewer PC so that LEFTSHIFT+RIGHTSHIFT

won’t bring up the ReachOut Viewer screen, type VIEW. It won’t have to
connect this time.

Disconnecting

When you are finished using ReachOut, you must break the connection.

To disconnect a ReachOut session

1. Bring up the ReachOut Viewer or Host. (CTRL+ESC brings

up the Viewer task list. If the viewing window is active,

press LEFTSHIFT+RIGHTSHIFT.)

2. Click the Disconnect button.

3. Click OK to confirm and end the session.

4. Click Exit to close ReachOut.

ReachOut for DOS

In DOS, choose Disconnect from Link menu. Choose Exit from the File
menu or press ESC to close the Viewer; this automatically removes
ReachOut from memory on the Viewer computer. In some cases, all the
ReachOut drivers can’t unload. If this happens, just restart your
computer to reclaim all the memory.

You can remove ReachOut’s DOS drivers from memory on a DOS Host
computer with UNLOADMH or UNLOADNH, depending on whether
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ReachOut is configured for modem or network. If other drivers were
loaded later, you’ll have to restart your computer to reclaim the memory.

Using the Terminal Emulator

The full-featured terminal emulator lets you make non-ReachOut
connections over a modem. You can use the same phone book that you
use for ReachOut Host connections to dial and connect to a remote
computer from the ReachOut Viewer. If you prefer, you can dial directly
from the terminal emulator.

To connect using the phone book

1. Start ReachOut Viewer.

2. Choose Connect Only from the Link menu.

 The phone book listing includes type T for terminal

emulator entries. However, if ReachOut connects to a

system that it doesn’t recognize as ReachOut, it

automatically invokes the ReachOut terminal emulator.

 To specify communications parameters (such as data

bits or parity), you’ll have to add an entry to the phone

book. From within the Add or Edit dialog box, check

Terminal Emulator Entry, then choose the Term Setup

button to specify parameters.

3. Select or type the remote computer’s phone number.

4. Choose OK.

5. Use the connected system as usual.

6. To disconnect from the remote computer, click the Hang

Up button or choose Hang Up from the terminal

emulator’s Link menu.
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To use the terminal emulator directly

1. Start ReachOut Viewer.

2. Click the Terminal Emulator button.

3. Click the Dial button just below the menu bar.

You’ll find full information about using the terminal emulator in
ReachOut Help. You can also print a document named TERMEM.TXT
from your ReachOut directory.

ReachOut for DOS

To use the terminal emulator directly under DOS, type VIEW to start the
ReachOut Viewer. Then choose Load Terminal Emulator from the Link
menu.

Automating ReachOut Sessions

ReachOut includes an extensive scripting language that you can use to
automate ReachOut sessions. You can even have the connection done at
or after a specified time. For example, a ReachOut script can connect to
your office computer, synchronize two directories, download your
e-mail, and disconnect.

For detailed information about using ReachOut’s scripting language to
automate sessions, open ReachOut Help and click Automating or
double-click the Automating icon in the ReachOut program group and
choose Topic Contents from the Help menu. The file AUTOMATE.WRI in
your ReachOut directory contains the complete text of the Windows help
for automating ReachOut.

Just double-click AUTOMATE.WRI in Windows File Manager to review or
print it using Windows Write.
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ReachOut lets you view and control one computer using the keyboard
and mouse of another. If you have computers at both your home and
office, you can completely control one from the other location. If you
find yourself in different offices over the course of the week, you can
always access your main computer, run programs remotely, and even
print wherever you are. This chapter shows you how to:

� Run applications on the Host from the Viewer

� Check and respond to your e-mail

� Use the remote clipboard to transfer small amounts of data between
the Host and the Viewer

� Use Chat to exchange messages with a user at the other computer

� Keep track of connections with the audit log

Suppose you are in a colleague’s office across town when you get an
opportunity to spend quality time with some experts in your field. You
can use ReachOut to connect to your office computer and check out
your e-mail before deciding how much time you can spend here. You
respond to critical issues, postpone a meeting for the afternoon, and you
are ready.

Suppose your manager calls you on the weekend from the office and
needs a report right away. You can connect to your office computer, do
the work, and print it there.
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The ReachOut Viewing Window

When you are viewing and controlling a Host computer, the Host
desktop is generally enclosed in a viewing window that includes the
name of the Host computer in the title bar. Double-click the ReachOut
Host icon to pop up the ReachOut Host screen on the Host and the
ReachOut Viewer screen on the Viewer.

Exactly what you see depends on several factors:

� If the Host display is smaller (in size or resolution) than the Viewer
display, you’ll see a viewing window that shows the full Host system
display, as shown here. You can move the window as needed. You
can resize it to less than full size to make it take less space on your
own desktop.

 

Viewing window

title bar

Host icon

Viewer desktop
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� If the Host display is larger (in size or resolution) than the Viewer
display, you might see a scrollable window showing part of the Host
system display. You can pan or use the scroll bars to see other parts.
Clicking the maximize icon enlarges the window as much as
possible. You can tell ReachOut to scale the display so it fits
completely  in a window.

 

� If the Host display is exactly the same size and resolution as the
Viewer display, your entire screen will show the Host computer’s
display, without any title bar. Use CTRL+ESC to switch to another
application.

ReachOut for DOS

From a ReachOut DOS Viewer, the Host display appears as a full screen.
Use LEFTSHIFT+RIGHTSHIFT to pop up the Viewer screen. Press ESC to
remove the ReachOut screen and return to viewing the Host computer.

Scroll bar

Viewing window

title bar

Viewer desktop

Viewer icon
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Managing the Viewing Window

While in a ReachOut session, you can manipulate the viewing window.
You can move it to another location, resize it, or minimize it. If you close
the viewing window, an application on the Host computer runs faster,
because it doesn’t have to update the screen.

ReachOut can scale the view of the Host desktop down so it appears in a
fixed (no scroll bars) window. Resize the window just as you do any
other window, but you can’t make it larger than its absolute pixel size.

To scale the viewing window

1. Bring up the ReachOut Viewer, if necessary.

2. Choose Viewer Options on the Preferences menu.

3. Click Scale Host to Window so the field is checked.

4. Choose OK.

Tip! Resize the viewing window by pointing the mouse cursor to a
lower corner. When the cursor changes to a double headed arrow, click
and drag the corner to resize the window.

When the view of the Host desktop is in a scrollable window, you can use
panning to change the portion of the desktop that you see in the window.
Panning lets you slide the view of the Host computer to another position
in the viewing window.

By default, ReachOut doesn’t pan. You can choose a panning hot key if
you want. ReachOut can use the right mouse button alone, the SHIFT key
pressed with the right mouse button or the CTRL key pressed with the
right mouse button.
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To set the panning hot key

1. Bring up the ReachOut Viewer window, if necessary.

2. Choose Viewer Options on the Preferences menu.

3. In the Pan Key field, choose your key combination.

4. Choose OK.

To pan the viewing window

1. Point to any location in the viewing window.

2. Press your Pan Key or Pan Key combination.

3. Slide the view to position it as you want.

4. Release the Pan Key.

Managing the Phone Book

ReachOut uses a phone book to make it easy to connect with other
computers. The phone book applies to Windows and DOS connections.
Here’s how the modem phone book looks before you connect:

Manage

phone

book

entries

Choose an

entry here

Type a

number here

or
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Each line contains a description, a phone number, and a type (R for
ReachOut or T for terminal emulator). When ReachOut is first installed,
the phone book has a single entry, which uses ReachOut’s terminal
emulator to call the Stac Bulletin Board System (BBS). You can easily
add entries for calling ReachOut Hosts.

Note: The modem and terminal emulator share the phone book. To
use the terminal emulator directly, click the button on the ReachOut
Viewer window. ReachOut Help includes full documentation.

To add a phone book entry

1. Start ReachOut Viewer, if necessary.

2. If you don’t want to connect, choose Edit Phone Book

from the File menu.

 If you prefer, you can choose a command that lets you

connect, such as Connect Only from the Link menu, or

click the Remote Control, File Transfer, or Chat button.

3. From the phone book, choose the Add button.

 

 If you select an existing phone book entry and choose

Edit, these fields show the current information.

Type phone

book

information in

these fields.



ReachOut for Windows & DOS

39

4. Type the Description (up to 32 characters) and press TAB.

 What you type here appears only in the phone book

listing. For example, you might use “Jim at Home” or

“Tjefferson.” If you want to use this description later in

an icon that lets you connect immediately, don’t leave

any spaces in your description. See Creating Connection

Icons later in this chapter for more information.

5. Type the phone number.

 Use up to 64 characters, with parentheses and dashes.

A comma embeds a short pause. You can include area

codes and other characters as needed.

 If you need the same prefix on all your numbers, such as

9 for an outside line, you can add a global prefix with

advanced modem configuration settings. Chapter 7,

Configuration, and ReachOut Help include details.

6. If the Host computer requires a user name, type it in the

User Name field.

7. If the Host computer requires a password, you can type

it (up to 16 characters) in the Password field. You’ll see

asterisks on your screen as you type.

 If you omit a required user name or password, ReachOut

asks you to enter it when you attempt to connect.

8. If the entry will call a non-ReachOut system, it needs the

terminal emulator. Check the Terminal Emulator Entry

field.

 This makes the Term Setup button available in case you

have to supply communications parameters. You’ll find

detailed information in ReachOut Help.

9. Choose OK.

Modify a phone book entry in much the same way; just highlight it and
choose Edit. Choosing Delete removes the selected phone book entry.
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ReachOut for DOS

To add, change, or delete DOS ReachOut phone book entries, pull down
the Preferences  menu and choose Edit Phone Book. The screen display
includes all the instructions you’ll need to maintain your phone book.

The Network Connect List

The network phone book looks and works much like the modem phone
book. The listing doesn’t require a Type, because the terminal emulator
doesn’t apply to networks. You can request a list of available network
Hosts on many networks. However, because of the time it takes to have
ReachOut search the network for Hosts, and the fact that you may not
have access to all those Hosts, most users use the phone book to list the
Hosts they call. The phone book lets you enter the password and user
name, so ReachOut won’t ask you for them while connecting.

Creating Connection Icons

Once an entry is in either the modem or network phone book, you can
create a special icon for your desktop and use it to connect directly to
that Host. The Host must be waiting, of course. For the connection to be

or

Choose a

phone book

or network

list entry

here

Type network

name here

Check here

to display

the

network

list
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fully automatic, the phone book entry must include any user name or
password required by the Host. The phone book description must not
include any spaces.

Use the VIEWER.EXE program in your ReachOut directory. If you prefer
to connect directly to ReachOut’s File Manager, use FILEMAN.EXE
instead.

To create a connection icon

1. Make the ReachOut program group active.

2. In the Program Manager, choose New from the File

menu.

3. Choose Program Item, then click OK.

4. In the Description field, type an icon caption, such as

“Viewing Home Computer”.

5. In the Command Line field, type

C:\REACHOUT\VIEWER.EXE PHONEBOOK=phonedesc

 Use the directory where your ReachOut files are located.

Use the description from the phone book entry for the

connection you want to make. The description cannot

include any spaces.

6. Click OK.

A special icon with the caption you specified appears in your ReachOut
group. Double-click the icon to connect immediately.

Printing while Viewing a Host

The Viewer Preferences dialog box lets you control several aspects of
printing during a ReachOut connection. You can redirect the Host
computer output in several ways, print to a file for later use, or flush the
print buffers.
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Redirecting Printing

Normally, when you print a file from the Host computer, it is printed as
directed by that computer. The Viewer can control where Host output
appears: at the Host, at the Viewer, both, or neither. In addition, you can
ask ReachOut to print to a file; you can edit the file later or copy it to a
printer.

Note: To redirect printing from a Windows 95 Host, see Redirecting
Printing in Appendix C, Window 95.

The Host controls whether or not redirection is possible. You may want
coworkers to be able to access your office computer on the weekend,
but you don’t want them to redirect the printing.

To prevent printer redirection

1. Bring up the ReachOut Host window, if necessary.

2. Choose Options from the Security menu.

3. Check Disallow Printer Redirection.

4. Choose OK.

Redirect printing

and flush the

print buffer

Scale, pan,

and hot keys,

plus other

features

Set DOS

features

Time before

disconnect
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To redirect Host computer print output

From the Host

1. Make sure Disallow Printer Redirection is not checked in

Host Security.

2. In the Windows Control Panel, select Printers and make

sure a driver for the Viewer computer is installed.

3. On the Host system, make sure the printer is connected

to LPT1.DOS.

 Note: If you have trouble printing, open the Control Panel and
choose Printers again. Click Connect and make sure Set Fast
Printing Direct to Port is not checked.

From the Viewer

1. On the Viewer computer, open the ReachOut Viewer

window and choose Viewer Options from the

Preferences menu.

2. In the Redirection field, choose Viewer Only. (Unless

someone is there, you don't want to rely on the Host

printer.)

3. In the Printer field, choose where redirected Host output

should appear at the Viewer site.

 You can choose from all the printers installed on the

Viewer computer. It does not have to match the printer

on the Host computer.

4. If you chose Spool file, type a name for your file.

 ReachOut will print the document to that file, and store it

in the Viewer's ReachOut directory.

Note: The Viewer printer driver must have the PASSTHRU feature, as
most Windows printer drivers do. If you find that redirection doesn't
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work, define a Viewer printer as HP LaserJet II and print to it. The
document will print just fine because formatting is done at the Host.

You’ll find full redirection details in ReachOut Help.

ReachOut for DOS

Under DOS, use the Host’s Security menu to allow or deny redirection.
Use the Viewer’s Printing menu to specify where to print.

Using the Remote Clipboard

When you are controlling a Host computer, you use its clipboard to
transfer data between Host applications. Similarly, you use the Viewer’s
clipboard to transfer data between Viewer applications.

ReachOut includes a remote clipboard that you can use to transfer data
between Viewer and Host applications in Windows. The Host controls
whether or not the remote clipboard is available. The Viewer uses the
remote clipboard.

The remote clipboard is very useful for transferring small amounts of
text and small graphics. For large text blocks and graphics, it’s faster and
uses less memory to save the data as a file and transfer it with File
Manager.

To turn the remote clipboard on or off

1. In the Host window, while not connected, choose

Options on the Security menu.

2. Click the Disable Remote Clipboard field so it is checked.

3. Choose OK.
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To paste data from the Viewer to the Host

1. From an application on the Viewer computer, place the

data in the Windows clipboard the usual way (with cut or

copy).

2. Access the ReachOut Viewer.

3. From the File menu choose Send Clipboard to Host.

4. Choose the format for the transfer and click Send.

 The list box shows the formats. You can choose as many

as you need, but choosing extra ones makes the process

take more memory and more time.

5. Through the viewing window, access the application to

receive the clipboard and paste it normally.

To paste data from the Host to the Viewer

1. From an application on the Host (through the viewing

window), place the data in the Host clipboard the usual

way (with cut or copy).

2. Access the ReachOut Viewer.

3. From the File menu choose Get Clipboard from Host.

4. Select the format for the transfer and click Get.

 The list box shows the formats. You can choose as many

as you need, but choosing extra ones makes the process

take more memory and more time.

5. On the Viewer desktop, access the local application to

receive the clipboard and paste it normally.
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Controlling Host and Viewer Actions

A user at the Host computer can normally use the computer while a
Viewer is in control. The Host user can certainly see everything on the
screen. Either the Viewer or Host user can start Chat to communicate
with the other user. Either can end the connection. And either can
disable the display at the other end.

As the Viewer, you can disable any mouse or keyboard input from the
Host computer. You might want to disable the display if you are
examining confidential data and the Host computer is in a public area.
You might want to disable input if there is no security in the area of your
Host computer.

To prevent user actions

1. Bring up the ReachOut Viewer (double-click the icon or

press LEFTSHIFT+RIGHTSHIFT when the viewing window is

active).

2. Choose Viewer Options from the Preferences menu.

3. To control a Host user, check Disable Host Input or

Disable Host Display.

 If you checked Disable Host Input, any use of the mouse

or keyboard at the Host PC have no effect. If you chose

Disable Host Display, the Host PC screen goes blank.

4. To make sure your local keyboard doesn’t interfere with

the Host user, check Disable Local Input.

 You can still use the ReachOut Viewer window and the

hot keys when local input is disabled.

5. Choose OK.
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Host Control of Viewer

While the ReachOut connection is active, a user at the Host can still use
the computer. There is no indication on the Host computer that a Viewer
is connected. Performance may be affected, because ReachOut
duplicates the screen on the Viewer computer.

For confidential work, the Host can disable the Viewer display or the
Viewer’s use of the mouse and keyboard. The Chat function lets the two
users coordinate their work.

To prevent Viewer actions

1. Bring up the ReachOut Host (double-click the icon).

2. Choose Viewer Options from the Preferences menu.

3. Check Disable Viewer Keyboard/Mouse or Disable Viewer

Display.

4. Choose OK.

Keeping Track of Connections

ReachOut can maintain an audit log with information on all connections
and attempted connections to a computer. An audit log can run on both
Host and Viewer. The file contains the date and time of each connection
and the length of the call, whether the computer is acting as a Host or as
a Viewer. On a Host computer, you’ll be able to tell if anyone tried to
connect and failed. ReachOut creates or adds to a file named
REACHOUT.AUD in the directory where your ReachOut files are stored.
Each time you start ReachOut Host, information is added to the log.
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To enable auditing

1. Bring up the Host or Viewer, if necessary.

On the Host

2. Choose Options on the Security menu.

3. Check Enable Audit Log in the Security window.

4. Choose OK.

On the Viewer

2. Choose Viewer Options on the Preferences menu.

3. Check Enable Audit Log in the Preferences window.

4. Choose OK.

If the audit file reaches 500 KB in size, ReachOut offers to delete it for
you. To save the audit log contents, copy the file and save it under a
different name. You may want to delete it periodically to save disk space.

You can examine and manage the audit log whether or not the computer
is connected. If a Host has a master password, you’ll have to enter it
before you can review its audit log.

To review, print, or delete the audit log

1. Pull down the File menu.

2. Choose Review Audit Log.

3. Click Delete or Print to process the file.

ReachOut for DOS

ReachOut DOS includes Audit Log on the Preferences menu for both the
Host and the Viewer; set the value on the submenu to On or Off. Review
Audit Log is on the File menu in both cases.
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ReachOut Security

The Host computer can use ReachOut Security to control access to its
files. Additional security is provided at the supervisor level for use on
networks. ReachOut provides extensive connection security, as well as
security for the File Manager and Drive Mapping.

Chapter 8, Security, covers the use of passwords, confirmation, and
callbacks in detail. Chapter 5, File Manager, covers File Manager
security. Chapter 6, Drive Mapping, covers security as it applies to Drive
Mapping.

More Host and Viewer Features

The following features help you control your ReachOut Remote Control
session. ReachOut Help includes complete explanations and shows you
how they work.

Voice and Data in One Session

If you have only one telephone line available during a modem
connection, ReachOut lets you switch from data to voice, then back to
data again. If your connected user has trouble explaining a problem
through Chat, you might want to have a voice conversation, then return
to the ReachOut session.

The appropriate commands are available on the Link menu when a
ReachOut modem connection is in progress. ReachOut Help has
complete details.

Inactivity Timeout

It is easy to run up huge telephone bills when connected through a
modem. And if several Viewers connect to the same Host in the course of
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the day, you want to make sure the Host is available when it isn’t actually
being used by a Viewer.

You can have ReachOut automatically disconnect if enough time passes
without any computer activity. You can set your preference for the
inactivity timeout value on either the Host or the Viewer. When the
shorter time passes, the connection is automatically ended.

Minimize Host on Startup

You may want the ReachOut Host window to be active whenever the
system is waiting for a connection. Or you may prefer that it be
minimized when it starts, whether from the StartUp group or by double-
clicking the icon. You can set your preference on the Host. When you
check Minimize on Startup in the Host Options dialog box, the Host is
minimized whenever it starts.

How to Chat

ReachOut’s Chat facility lets users at both connected computers
exchange typed messages.  Either user can start Chat by clicking the Chat
button in the ReachOut Host or Viewer.

Once the Chat window appears, either user can use Page to alert the
user at the other end with a bell, much like a ringing telephone. Both
users can type at the same time. Messages from the other user appear in
the upper part of the window.
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You can use your local Windows clipboard to  paste small amounts of
text into the message area or to copy text from it to a local document.
The Edit menu includes commands to copy from the connected
computer (the upper portion of the Chat window) and Paste to your
local computer. Choosing Copy from the Edit menu places the entire
contents of the upper portion for the entire Chat session into the local
Windows clipboard. You can make any local application, such as an
editor, active, and choose Paste to Local.

Either user can press ESC or choose Exit to end the discussion. The two
computers remain connected.

ReachOut for DOS

To start Chat in a DOS session, press LEFTSHIFT+RIGHTSHIFT at the Viewer
or ALT+RIGHTSHIFT at the Host and choose Chat. During Chat in DOS, the
messages for the two computers appear side by side. The display lets you
know how to alert the other user or end Chat.

What you type

appears here

What the

connected user

types appears

here
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The ReachOut File Manager helps you manage files and transfer them
between two connected computers. When you aren’t in the office, you
can connect to the office computer every day and transfer your data files.
You may pick up other files containing data you need in your work.
ReachOut can synchronize directories for you. And it saves connection
time by transferring only the differences between existing files.

With ReachOut File Manager, you can:

� Transfer files between connected computers

� Synchronize directories

� Start operations from the Viewer

� Monitor operations from the Host

Suppose you are on the road and need to update your working directory
on your laptop each night. Connect to the office computer, tell ReachOut
to synchronize your directory with one on the office network. ReachOut
transfers the differences in the later files and gets the computers ready
for the next day’s work.

Windows 95 Long File Name Support

If both of the connected computers use Windows 95, you can use
ReachOut File Manager to transfer files and still keep their long file
names intact. If just one of the connected computers uses Windows 95,
ReachOut for Windows & DOS may truncate or ignore long file names.
See Appendix C, Windows 95, for more information.
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The File Manager Display

The ReachOut File Manager helps you transfer files from one computer
to the other.

To start File Manager

1. Start the ReachOut Viewer.

2. Click File Transfer to connect to a ReachOut Host.

If you are already connected, bring up the Viewer and click File Transfer.

ReachOut for DOS

To connect directly into the File Manager, from the Link menu, choose
Invoke File Manager from the Once Connected submenu. If you are
already connected, choose Invoke File Manager from the File menu.

It works much like the Windows File Manager. You can see the
directories and files on both the local and remote computers as shown
here.

Local drives,

directories,

and files

Host drives,

directories, and

files

Menus

apply to

active

window

Arrow shows

direction of

transfer
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To switch active windows

• Click anywhere in the other window.

 or

• Use the Goto commands on the File or Directory menu.

Handling Drives and Directories

To display a different drive, click the drive icon. To change to a different
directory, click the directory icon or use the Change command on the
Directory menu. You can use standard Windows techniques or the
Directory menu to create, delete, or rename a directory on either
computer.

Handling Files

The ReachOut File Manager lets you select, copy, rename, and delete
files just as you do in Windows. You can use drag-and-drop to copy
selected files to the other window. Just as in Windows File Manager, you
highlight the files you want to copy, press the left mouse button, and
drag to the other window. The Copy, Delete, and Rename commands
from the File menu affect all selected files.

ReachOut includes several features you might want to use when you
transfer files. You can specify them on the Options menu.

To do this ... Choose ...

Save transfer time Compression

Protect your system from viruses Virus Checking

Alert you after a transfer Sound

Let you confirm copies or deletions Confirmation
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SmartSend™

By default, ReachOut uses a smart transfer method that copies only the
differences between files being transferred. When a file with the same
name exists on both source and destination disk, ReachOut can send
only the difference between the two files. The Smart Transfers option on
the Options menu lets you control how ReachOut identifies differences.

To transfer ... Choose ...

Differences in files that have different dates,
times, or sizes

Standard

Differences in all files Vigorous

Complete files, regardless of differences Disable

When a transfer is interrupted, ReachOut File Manager normally reacts
just as the Windows File Manager does. It deletes the partially
transferred file in the destination directory. If you are using Standard or
Vigorous SmartSend, you can ask ReachOut to save any partially
transferred file; check Save Partial Transfers on the Options menu. The
next time you start up File Manager, you can resume the transfer from
the point of interruption by copying the file again.

Selecting and Tagging Files

You select one or more files in the ReachOut File Manager by clicking
them, just as you do in Windows File Manager. In addition, ReachOut
tagging lets you select files that meet certain criteria. For example,
suppose you want to transfer any files in the Host WORKING directory
that were modified after a certain date to the local computer’s WORKING
directory. You can Tag those files, then choose Copy. Tagging works with
selecting; any tagged files are selected in addition to those that are
already selected. To select additional files after using Tag, be sure to hold
down the CTRL key while you select them.
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To select files that meet certain criteria

1. Choose Tag from the File menu.

2. Click the criterion in the Tag dialog box.

3. Click OK.

When you choose Tag from the File menu, you see this dialog box.

Tagging selects files in the active directory in the active window. The
Equal, Modified, and New types compare files there with those in the
directory currently displayed in the inactive window. Tagging selects files
that are identical (Equal), have the same name but a different date or
size (Modified), or are present in the active window but not the inactive
window (New).

You can choose either Tag or Untag. You can use Tag repeatedly to select
or deselect additional files. Suppose you want to select all files with
extension PCX except for those whose file names begin with X. Use Tag

Tag based

on date

Tag based on

files stored on

the other

computer

Click Tag or

Untag

Tag using * and ?

wildcards
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once with *.PCX as the Specify Files entry. Then use Tag again with
X*.PCX as the Specify Files entry and click Untag.

ReachOut Help contains more details about the various tagging options.

Synchronizing Directories

Many people synchronize directories on two computers. You may want
to back up all changed files in a directory, or you may want to reproduce
a directory from your office computer on your home computer so all
your files are available. ReachOut uses RapidSync™ to synchronize
directories on two computers in several ways.

� Clone a directory. ReachOut can create a new directory on one
computer that is identical to one on the connected computer.

� Make two directories identical. If file names match, File Manager
copies the more recently dated file to the other computer. If a file
exists on one computer but not the other, File Manager copies it to
the other one. For this method, it doesn’t matter which computer or
directory is active in the File Manager.

� Bring a directory on only one computer up to date by copying in
only one direction. You’ll have to make the window (or computer)
that contains the files to be copied active before choosing
Synchronize. File Manager copies a file from a directory on the
active computer if it is has a more recent date than the one being
synchronized. If a file exists only in the directory on the active
computer, File Manager copies it to the one being synchronized.

� Transfer matching files with different times and dates from one
computer to the other, but do not copy files that exist in only one of
the directories to the other computer.

Note: If you are synchronizing directories between a Windows 95
system and one that runs an earlier operating system, ReachOut
ignores any files with long file names.
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To synchronize directories

1. Start File Manager, if necessary.

2. Make the directory to be synchronized on each computer

current.

3. Make a computer from which files will be copied active.

4. From the Directory menu, choose Synchronize.

 

5. To use less than full synchronization, check the field:

• Synchronize Only Existing Files or

• Local to Host Transfer Only or Host to Local Transfer

Only

6. Click OK.

Creating a duplicate directory in another location is sometimes called
cloning a directory. You can use RapidSync to clone a directory on one
computer to the other.

To clone a directory

1. Create a new directory on the computer to receive the

clone and make that directory current.

Name one directory

Name the other

Check if needed
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2. On the other computer, make the directory to be cloned

active.

3. From the Directory menu, choose Synchronize.

4. Click OK.

Controlling the Display

The ReachOut File Manager includes several ways to manage the display.
Use the View menu to specify how you want it to appear.

When Directory Tree is checked, you see a directory tree and file list
window for each computer. You can click on a collapsed or expanded
directory icon in the directory tree to expand or collapse it. Use
Collapse/Expand on the Directory menu to control this without a mouse.
When Directory Tree is unchecked, you see only the file list window for
the current directory on the current drive on each computer. In this
condition, the windows are side by side.

You can also control the contents of the File List window. When File
Names Only is checked, that’s what you see. When it is unchecked, you
can specify which details (size, date, time, and attributes) you want
listed. In addition, you can specify the order in which files are listed and
an overall filter, such as *.PCX, that limits the display. These features
work much as they do in Windows. Details on using these features are
included in ReachOut Help.

The File Manager Log

While the ReachOut File Manager is active, a user at the Host computer
can examine the File Manager log. ReachOut minimizes the File Manager
log on the Host when File Manager starts. At the Host PC, double-click
the icon to see what is going on. Files are transferred more quickly when
the File Manager log is minimized.



ReachOut for Windows & DOS

61

Note: If the Viewer has disabled the Host display, you won’t be able
to view the File Manager log.

If you press the Exit button, ReachOut cancels File Manager, including
any activity currently in progress. It does not disconnect the two
computers.

File Manager Security

As a Host, you may want to control what connected Viewers can do and
see with your files. For example, you may want Viewers to be able to
copy files to and from your computer, but not to delete or change any
existing files. Or you might want users to be able to control your
computer, but prevent them from copying confidential files from your
computer. To change most security features, ReachOut must be
disconnected.

Note: See Chapter 8 for full information on ReachOut security.

Operation in

progress

About the last file

transferred

Record of

session activity
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File Manager security can be set at several levels:

� At the individual password level in the Host password list. You can
set different access for different Host passwords or user names.

� At the Host level, where it applies to all incoming calls. You can set a
maximum access for any Viewer that connects.

� At the supervisor level, where it applies to all Hosts that use that
version of ReachOut. You can set a maximum access for Viewers
connecting to any Hosts within your control.

To let the Viewer ... Give this access ...

Do all operations Full

Copy files to and from the Host Read/Write

Copy files from the Host Read Only

Not even view the file list None

In the Host Password List, you can specify File Manager access when you
add or edit a password.

The Host can override all individual File Manager security, specifying the
highest access that applies to any incoming Viewer. The Host cannot set a
higher level than that established by the supervisor.

To limit File Manager access from Host
security

1. Start the ReachOut Host, if necessary.

2. When not connected, choose Options from the Security

menu.

3. In the File Transfer Access field, choose the maximum

access you want to allow.

4. Choose OK.
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Supervisor security takes precedence over Host security. Chapter 8
covers supervisor security in detail.

To limit File Manager access from Supervisor
Security

1. When not connected, double-click the Supervisor

Security icon in the ReachOut program group.

2. In the File Manager Access field, choose the highest level

of access permitted.

3. Choose OK.

Limiting Specific Access

Suppose you want users to see and work with some of your files in the
ReachOut File Manager, but not all of them. You can control which
drives and directories appear in the Host section of the ReachOut File
Manager. If the file doesn’t appear in the window, the user cannot
perform any actions on it through the File Manager. The drives and
directories you exclude are not available to any Viewer using File
Manager.

Limiting access to certain drives or directories during ReachOut File
Transfer depends on a file named REACHOUT.PRO in the ReachOut
directory. You can create this file if it doesn’t exist using any text editor,
such as Windows Notepad or DOS Edit. Here’s a sample REACHOUT.PRO
file. This one makes the ReachOut and DOS directories and the D drive
unavailable to the Viewer’s ReachOut File Manager.

c:\reachout
c:\dos
d:



Chapter 5 •• File Manager

64

To modify your REACHOUT.PRO file

1. Start a text editor such as Notepad or DOS Edit.

2. Open the file C:\REACHOUT\REACHOUT.PRO.

 If the file doesn’t exist, some editors will create it. In

other editors (such as Notepad), you choose New from

the File menu to create it.

3. Type the ReachOut directory path and name on the first

line to make sure users can’t change this file!

4. On a separate line, type the drive name or path of each

drive or directory you wish to hide from the ReachOut

File Manager.

5. Save the file.

Additional steps you can take to protect individual files, including
REACHOUT.PRO, are to make them hidden or read-only. If you do this,
be sure to remove ATTRIB.EXE and similar programs from your Host
computer.

Note: Security changes made in either Windows or DOS affect
ReachOut when used in the other environment.



Taking remote control of a computer isn’t always the best method of
gaining access to your data. Some graphics-based programs and other
applications need to transmit unusually large amounts of data over the
ReachOut link, and may be too slow to run effectively from a Viewer.

Fortunately, ReachOut provides a way to make drives on the remote
computer automatically available when you connect—you don’t have to
run the viewing window or any other ReachOut application. With Drive
Mapping, ReachOut creates a link between the directory structures of
two computers. Accessing remote files becomes as easy as accessing files
from your own hard disk, CD-ROM, network connections, or any other
drives defined on your system.

Drive Mapping lets you:

� Run an application locally, and access only data from the other
computer

� Allow the Host to access data on the Viewer, as well as the other way
around

Drive Mapping solves the problem of what to do when the drive you
need is on a different computer. ReachOut Drive Mapping effectively
turns the Host or the Viewer into a network server, even when you are
connected with a modem!
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How Drive Mapping Works

ReachOut Drive Mapping requires a Server and a Client. The Server is
the computer that actually contains the drive you want to access; the
Client is the computer you run the application on.

You set up a drive mapping from the Server to the Client so that when
you connect, the Server drive or directory is available as a new drive to
the Client.

If you are controlling a Host computer from a Viewer, you can share
drives and directories with the Host, allowing you to use Drive Mapping
in conjunction with Remote Control. Then when you connect, your local
drive is available as a new drive on the Host. You can use Remote
Control to open a Host application and edit Viewer files without actually
copying the files to the Host computer. This feature can be useful if you
do not want copies of your files to exist on the Host computer, or if your
ReachOut File Manager access to the Host is limited to Read Only.

You can also map drives the other way. Suppose your ReachOut Host is a
Server. The Host makes the path C:\SALES available to a Drive Mapping
Client. When you connect as a Viewer, the Host Server’s directory

Use drive D to

access the

Server’s drive C

Use drive H to

access the

Server’s drive H
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C:\SALES gets mapped to a drive (say D:) on the Viewer—which is the
Client.

The Client’s D drive now points to the directory C:\SALES on the Server.
In other words, the remote directory C:\SALES is the root of drive D. The
entire directory structure from C:\SALES down is available on the Client’s
drive D. To open the file C:\SALES\Q1\MARKET.XLS, just change to D:\Q1
and it’s there. But the file is still stored in C:\SALES\Q1 on the Server
computer, so it is available from both computers.

The Server can make available any of its directory paths, including those
stored on network, CD-ROM, or floppy disk drives. For security reasons,
the Server can set a path to Read Only or Write Only. Unless a master
password exists for the Server, the Client cannot set up Server options or
add Server directories to its drive mappings.

When Should You Use Drive Mapping?

Here are some situations in which you might use Drive Mapping.

� You want to use drives on a remote computer but execute programs
only on the local computer. For example, it might be difficult to use
remote copies of large graphics-based programs because of the
amount of data that needs to be continually transferred. But if you
run the program locally and just open files that are stored on the
remote computer, ReachOut transmits data across the link only
when you perform file operations.
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� You want to use your office e-mail but you can’t run the e-mail
software on your computer. You can create the mail messages and
any file attachments and save them to your local computer before
connecting. This way you keep connect time to a minimum, which
can help reduce cost if you are using a modem. Use Drive Mapping
to map your hard drive to a drive letter on the remote computer.
Then connect to the Host, remotely run the e-mail program, and
attach files from your local drive. You can also retrieve your e-mail
by serving up the office network mail directory to your computer.

� You want to process local data on the remote computer. For
example, you might be working at home and want to send your file
to an office printer so someone else can read it. Instead of going
through the two-step process of copying the file to the office
computer and then opening it in an application, you can open it
right from your home computer’s drive, saving connection time.
This is particularly valuable if you aren’t sure which file it is and
need to examine several before printing.

� You want to back up data on a remote computer by using a tape
drive or other hardware connected to yours. You could also back
up your local computer using the tape drive of a remote computer.

� You want to install new software on the remote computer. Many
software packages force you to install from floppy disks to help
prevent piracy, making remote installs impossible. With ReachOut,
you can map the local floppy drive, then do the install remotely.

� Version control: You want to have the most current copy of a file
always stored in the same place so the wrong version doesn’t get
edited. With Drive Mapping you can edit that file whether it is on a
local or a remote drive.

� Peer-to-peer networking: You want the Host user to have access to
directories on the Viewer, as well as the other way around. Through
Drive Mapping, users at the Host and the Viewer can share drives
with each other.
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Setting Up Drive Mapping

There are three steps required to use ReachOut Drive Mapping:

� First, enable Drive Mapping on the Server.

� Then, create drive mappings on the Server using Share Drives.

� Finally, connect.

You must enable Drive Mapping and run Share Drives to create your
drive mappings before you connect.

To enable Drive Mapping

1. On the Server computer, open the ReachOut Host or the

ReachOut Viewer.

2. From the Preferences menu, choose Drive Mapping.

3. Check Enabled on the secondary menu.

ReachOut for DOS

1. Change to the ReachOut directory and type RASETUP to

run the Drive Mapping Setup program.

2. Under Go Host and Go Viewer, check or uncheck the

Client and Server options.

If you want to be able to share drives with another

computer and also map drives from another computer,

you must check both Client and Server.

3. Press ENTER to accept the changes and exit RASETUP.

 Note: In DOS, you must set up both the Server and the Client.

Sharing Your Drives

Share Drives defines the Server directories that will be available to the
Client. Run Share Drives on the Server before you connect to a Client.
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To share Server drives

1. Open the ReachOut Host or the ReachOut Viewer.

2. From the Preferences menu, choose Drive Mapping, then

choose Share Drives from the secondary menu.

3. Choose Add to add a new entry.

4. Under Drive, choose the drive letter that the ServeUp

Path will be mapped to on the Client.

 To have ReachOut automatically assign the next

available drive letter, choose Next Available from the list.

 

 IMPORTANT! If you choose a drive letter that the Client is
already using, the mapped drive overlays it, making the Client
drive unavailable while you are connected.

5. Type the full path name of the directory you want to

make available to the Client.

 You can also enter this path by double-clicking directory

names in the browse list below.

6. Specify the type of file access allowed to the Client.

7. Press ENTER or choose OK to accept the mapping.

8. Choose Yes to save your changes.

 You can also save changes by choosing Save from the

File menu. You must save the changes before you

connect or the drives will not be mapped.

ReachOut for DOS
 To share drives in DOS, change to the ReachOut directory

and type SERVEUP, then follow steps 3 through 8 above. If

Choose the Client drive

letter from this list

Type the

ServeUp path

here
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you have already saved Drive Mapping files in the ReachOut

directory, you will be prompted to choose one.

 Leave the drive letter field blank to have ReachOut

automatically assign a drive letter.

You can edit or delete any of the mappings by selecting them from the
Share Drives list and choosing the appropriate command.

Creating Separate Drive Mapping Files

By default, your drive mappings are stored in a file called SERVEUP.SRV
in the ReachOut directory. But you can save your Drive Mapping file
under a different name by choosing Save as from the Share Drives File
menu. If your computer is a Host, you can define multiple passwords
and associate a different Drive Mapping file with each one.

To attach a Drive Mapping file to a password

1. Open the ReachOut Host.

2. Choose Edit Passwords.

3. Select a password and choose Edit, or choose Add to

create a new password.

4. In the Password List Entry dialog box, choose the

Adv. Options button.

5. Under Drive Mapping file, type the name of the Drive

Mapping file without the file extension .SRV.

 For example, type NETDRIVE instead of NETDRIVE.SRV.

6. Choose OK and exit the Password List.

When a Viewer connects as a Server and uses this password, the drive
mappings in the associated Drive Mapping file take effect. This way you
can share different drives with different users.
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Changing Mapped Drive Letters

Once connected, the Client can use Map Drives to change its drive
settings.

To change Client drive mappings

1. While connected to a Server, bring up the ReachOut Host

or Viewer window.

2. Choose the Map Drives button.

3. The paths listed are Server paths, assigned to Client

drive letters. Add, delete, or edit the selected drive

assignment by choosing the appropriate command.

ReachOut for DOS

Change to the ReachOut directory and type RAMAP to run

Map Drives.

IMPORTANT! The Client drive letter must be a valid drive letter
on the Client computer. To define valid drive letters use the LASTDRIVE
command in your CONFIG.SYS file; for example, LASTDRIVE=E allows
the letters A through E to be used as drive letters. See the MS-DOS
documentation for more information.

Using Drive Mapping

Once you have set up your server paths, you are ready to use Drive
Mapping. Simply connect by following the procedures described in
Chapter 3. If you just want to use Drive Mapping, you can connect
without starting any other ReachOut function.
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To connect without opening a window

• From the Link menu of the ReachOut Viewer, choose

Connect Only.

The drive mappings automatically take effect. Remember that the drive
mappings may depend on the password you use to establish the link.

To view the mapped drive contents

1. From the Windows Program Manager, open File

Manager (usually in the Main group).

2. In any File Manager window, click on the drive letter icon

of the mapped drive.

 The File Manager window is updated to display the

contents of the drive.

To access files from within an application

1. Open any application.

2. Change to the mapped drive, or type in the complete

path.

3. Choose a file to open.

You can use the mapped drive just as you use any other drive.
Depending on the amount of access allowed to the Client, you can open,
save, rename, and delete files on the mapped drive.

ReachOut for DOS

You can use the mapped drive as you would use any other drive. If the
mapped drive letter is E, type E: at the prompt to change to that drive.

You can use the ReachOut batch files to automate file transfers over
mapped drives. Contact the Stac BBS or Stac Fax for updated technical
documents describing this procedure.



Chapter 6 •• Drive Mapping

74

Drive Mapping Security

ReachOut Drive Mapping includes Read/Write settings you can use to
determine the level of access allowed to Client users. Set the Read/Write
options in Share Drives when you configure your Server directories.

IMPORTANT! Drive Mapping Read/Write options are independent
of ReachOut File Manager security options (see Chapter 5).

Read/Write Options

Whether the Server is the Host or the Viewer, you can specify one of
three levels of access for each Server path.

� Read/Write: This option allows full access to the mapped
directories, including the ability to create, rename, and delete files
and directories.

� Read Only: This option allows the Client to open files located on
the Server drive, or to copy them to another drive. Once a file is
copied to a writable drive, the Client owns the copy and may edit,
rename, or delete it.

� Write Only: This option allows the Client to save or copy files to the
Server drive, as well as rename and delete files on the Server drive.
The Client cannot open or copy files already stored on the drive, so
the Client is prevented from viewing sensitive data. This option is
useful if you want to allow Clients to back up their information to
the Server without being able to open Server files. We recommend,
however, that you create an empty Server directory for this purpose,
so that files already existing on the Server cannot be renamed or
deleted.
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Adding New Paths From the Client

A Client must use the Server’s master password to change a ServeUp
path. The Client must be the Viewer and the Server must be the Host. The
Client can then run Share Drives in the ReachOut viewing window.

To change the ServeUp path from the Client

1. From the ReachOut Viewer main window, choose

Remote Control.

2. In the viewing window, run SERVEUP.EXE from the

Client’s ReachOut directory.

 You can do this by double-clicking on the file name in

Windows File Manager.

3. When prompted, enter the master password.

4. Edit the ServeUp paths as desired.

Note: You must save the changes to the Drive Mapping file,
disconnect, and reconnect before the new drive mappings can take
effect.

For more information on master passwords, see Chapter 8, Security.
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You can change the way your computer is set up for remote
communication with ReachOut’s Configuration utility. The Install
program automatically uses the utility for your initial configuration.

Suppose you changed your modem or attached it to a different
communications port. Just double-click the Configuration icon in the
ReachOut program group and tell ReachOut what the changes are.

You can also use the Configuration window to switch from using a
modem connection to using a network connection or to modify network
parameters. ReachOut remembers the latest configuration for each
connection type, so all you have to do is select the type you want and it’s
ready to use.

Suppose you use ReachOut over a modem to control computers at work.
You also want to use it over the Internet occasionally. Use the modem
configuration for normal ReachOut work. Configure ReachOut for the
Windows Sockets for use over the Internet. Once you are on the Internet,
use the ReachOut’s Internet configuration to control a waiting Host.

This chapter shows you how to:

� Select a different modem

� Change network or modem pool settings

� Configure ReachOut to connect over an ISDN line

� Modify how ReachOut handles a DOS session

� Switch between different connection types
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Connection Types

ReachOut supports several different connection types, depending on the
choices you made during installation. You configure one connection
type when you install ReachOut. You can configure other types and
switch between them using the Configuration icon in the ReachOut
program group. You can also configure ReachOut from the Preferences
menu within the Host or Viewer.

Type What it does

Modem ReachOut handles hundreds of different
modem types. You can even define a new
modem if yours isn’t listed.

Network ReachOut handles the most common networks,
including Novell’s NetWare, Microsoft LAN
Manager’s NetBIOS, Banyan VINES, Windows
Sockets, and FTP TCP/IP networks.

Modem Pool/ACS ReachOut handles common ACS arrangements
for sharing modems, as when several modems
are available to network users.

Direct Connect Cable ReachOut lets you control a computer
connected directly by a null modem cable to
your computer through the COM ports.

Internet ReachOut sets you up to use Windows Sockets
network protocol.

Remote Node ReachOut lets you connect over a network that
you joined using remote node software.

ISDN ReachOut lets you connect over an ISDN line.

Cellular Modem ReachOut lets you choose a cellular modem.
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ReachOut uses one connection type at a time. You may use ReachOut to
control other computers on the network when ReachOut is configured
for a network. To use ReachOut to control computers outside a network,
you can use an individual modem, a modem pool, an ISDN line, or a
direct connection.

Starting Configuration

ReachOut’s installation program prompts you to configure ReachOut for
your first use. You can specify additional options or change your
connection type from within the Host or Viewer.

Changes to a computer’s current type of configuration take effect the
next time you connect to another computer.

To start the Configuration utility

1. In the ReachOut program group in Windows Program

Manager, double-click the Configuration icon.

2. Choose the type of connection you wish to configure,

then click OK.

 

Choose one

connection

type to

configure
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3. If the master password dialog box appears, type the

master password, then choose OK. (See Chapter 8 to

learn how to define a master password.)

Note: From the ReachOut Viewer or the ReachOut Host window, you
can use the Preferences menu to Select Connection Type or Configure
Connection Type. If you select a type that isn’t yet configured, the
Configuration window opens automatically.

ReachOut for DOS

To open a Configuration window in DOS, change to the ReachOut
directory, and type SETUP at the DOS prompt. You’ll be able to manage
the phone book and password lists as well.

To configure ReachOut to use a network or modem environment for the
first time, if you didn’t do it during installation, type CONFIG instead.

The Configuration Window

The main Configuration window has similar areas no matter what
connection type it deals with. For example, here’s how it looks if you are
configuring for a modem:

Change

connection type

information here

Change

computer

name here



ReachOut for Windows & DOS

81

The ReachOut Configuration window always includes the
Communications section and the Computer Name. The fields in the
Communications section vary according to the connection type being
configured. For a modem, you see the port, the transmission speed, and
the modem for which ReachOut is currently configured. When you are
configuring a network or modem pool, the Configuration window
includes additional sections.

The File menu lets you create a new ReachOut program group if that
becomes necessary, put the Host in the StartUp group, Disable the
Window Host, or exit Configuration. When you choose OK, any
configuration changes are saved automatically.

Changing Modem Settings

If you change your modem, you must tell ReachOut what the new
modem is (name, model number, transmission speed, and so on)
before using it to connect. If you change any of your modem’s features,
you must also inform ReachOut.

Tip! Windows 95 users can use their existing modem settings with
ReachOut for Windows & DOS. Appendix C, Windows 95, shows you how.

Use the Modem Configuration window to make modem setup changes.

To do this ...
Use this
field ...

Specify the communications port your
modem is connected to (such as COM1).

Port

Choose your data speed. For modems up
to 9600 baud, use the modem rate. For
higher speed modems, depend on your
UART speed. See Appendix A for more
information on setting speed.

Baud
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To do this ...
Use this
field ...

Choose the type of modem and model
number (such as Hayes Accura 14.4).

Modem

Change your computer’s name. This
name appears in connection lists and on
connected computers.

Computer Name

ReachOut for DOS

Change to the ReachOut directory and start SETUP, then use commands
on the Comm Settings menu to change the configuration. Commands on
the File menu let you save the configuration.

Selecting a Different Modem

If you’ve changed the modem attached to your computer, you’ll have to
configure the new one. Both internal and external modems are attached
to a communications port.

To configure a new modem

1. Start Configuration. Choose Modem if necessary.

2. In the Modem field, choose the exact type of modem.

 If your modem isn’t listed, choose “A Hayes Compatible

2400” from the list.

3. In the Port field, choose the correct COM port.

 If you are changing from an older modem, the port has

probably not changed.

4. In the Baud field, set the data speed based on your UART

chip.
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 The speed may be greater than the bits per second or

baud rated for your modem. For modems of up to 9600

baud, use the rated speed. For higher speeds, you can

try the next higher speed in the drop-down list.

Additional Modem Settings

You may want to specify different settings for some of your modem’s
features. For example, suppose you want to change the timeout value, set
a general calling prefix, or turn off data compression or autobaud. You
do all this and more through the Advanced Settings dialog box.

To specify advanced modem settings

• From the Configuration window for your modem, click

Advanced Settings.

 

Tip! If your telephone uses pulse rather than tone dialing, change
the dialing prefix from ATDT to ATDP. It will apply to all outgoing calls.

You’ll find full details for using all advanced settings in ReachOut Help. If
you use the Modem Config button to add a new modem to the modem
list, you’ll need the modem’s documentation for information.

Change or

specify modem

settings

Change

ReachOut

settings

Change the dialing

string; add 9 for an

outside line

Define a

modem
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Configuring for a Network

Before you can use ReachOut over a network, you must configure it for
the network you use. If you work over more than one network, you can
reconfigure ReachOut to switch between them. In addition, you can
modify settings including your file server, the computer name and
description for the network list, and the timeout for preparing the
network list.

Your Computer Name and Network List Description appear in
ReachOut’s network list when a Viewer tries to connect over your
network. The name and description can use any alphanumeric
characters. The Name is limited to 16 characters, the Description to 32.

When a Viewer is ready to connect over a network, the ReachOut
Connect dialog box lets you request a list of waiting Hosts on the
network. The Computer Name and Network List Description appear in
that list. The List Request Timeout specifies how long ReachOut should
search the network for waiting Host computers.

Shows how

long

ReachOut

looks for

Hosts

You can change

the Name and

List Description
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Specifying the Network

Your ReachOut computer can connect to another ReachOut computer
on any of these networks or a network that is compatible with them:

� Novell’s NetWare IPX/SPX

� Any NetBIOS

� Windows Sockets

� Banyan VINES

� FTP TCP/IP protocol

Additional Network Settings

Each network type may require some additional settings. Use the
Advanced Settings dialog box to specify values specific to the network. In
most cases, the default values apply.

To specify additional network settings

1. In the Communications field, select the type of network.

2. If it’s available, click the Advanced Settings button.

The dialog box that appears depends on the selected network. If you
aren’t sure what to do, click the Help button for details.

To configure for use over the Internet

• Choose Windows Sockets (for use under Windows) or

FTP TCP/IP (for using the Internet under DOS).

To connect to a ReachOut Host over the Internet, you must provide the
Host’s IP address in your phonebook or in the connection dialog.

If your computer uses a modem to access the Internet, connect to the
Internet first, then start ReachOut Host or Viewer. If your computer is
already on a network with Internet access, run ReachOut as usual.
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Configuring for a Modem Pool

A group of modems shared by computers on a network or by a single
computer make up a modem pool. Special ACS (Asynchronous
Communications Services) software controls the availability and assigns
modems as needed. Suppose the network at your office includes a bank
of shared modems. When you start a ReachOut session to a user who
isn’t on the network, the modem pool assigns one of its modems to your
computer.

The Modem Pool software is a communications interface that makes it
appear as though a modem is physically attached to your computer. It
selects a modem when ReachOut needs one. You don’t need to know
exactly which modem is used each time you connect.

You’ll use the Modem Pool configuration window to switch to the
Modem Pool configuration or to modify your current modem pool
setup. Individual fields are the same as for a modem configuration.

Your ReachOut computer can connect to a modem over any of these
types of ACS standards or a system that is compatible with them:

� NetWare Connect

� NASI / NCSI

Modem pool

software

Specialized

settings



ReachOut for Windows & DOS

87

� Telebit ACS

� Modem Assist Plus

� Int14 / 6 Banyan

Modem Pool Settings

Each modem pool type requires some additional information.

To configure the modem pool

1. In the Communications field, select the type of modem

pool software. Click ACS Settings if necessary.

 The resulting dialog box requests information specific to

the type of modem pool. Click Help for details.

2. Enter the appropriate information, then click OK.

3. To specify additional information related to modems in

the pool, click the Advanced Settings button.

 

 Check ReachOut Help if you need details.

Configuring Direct Connections

If your computer is connected to another computer with a null modem
cable, you can set ReachOut to communicate with it directly.
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If you installed ReachOut only for serial and ACS connections, Direct
Connect is not on your initial configuration list. In that case, choose
Modem when Configuration offers you a choice. From the modem list,
choose Direct Connect (Null Modem Cable).

To specify a different port for Direct Connect

1. Start Configuration, and choose Direct Connect.

2. Select the appropriate Port field, and click OK.

For details on changing other Direct Connect options, read Changing
Modem Settings earlier in this chapter or see ReachOut Help.

Configuring for an ISDN Line

An Integrated Services Digital Network (or ISDN) line is a special type of
telephone line that uses only digital communications. ISDN lines let you
send and receive data much faster than normal telephone lines.

ReachOut supports two configuration options for ISDN connections.

ISDN Modem

Use the ISDN Modem configuration if you have an ISDN modem on your
COM port. When you choose Modem as your ISDN type, ReachOut’s

Specify the

correct COM

port
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modem selection defaults to an ISDN modem. The other fields function
as they would if you were configuring ReachOut for a regular modem.
For details, see Changing Modem Settings earlier in this chapter.

ISDN CAPI Terminal Adapter

An ISDN terminal adapter sends data using an ISDN protocol instead of
modem commands. ReachOut supports the CAPI 2.0 protocol.

To configure ReachOut with ISDN CAPI

1. Start Configuration, and choose ISDN.

 

2. Under Type, choose CAPI.

3. For Local ISDN, type the phone number of the ISDN line.

 Certain ISDN functions use or display this number.

ReachOut for DOS

To set up ReachOut for ISDN in DOS, change to the ReachOut directory
and enter CONFIG. You’ll see the ISDN configurations as setup choices.

Changing DOS Settings

If you’ll be using ReachOut in Windows to control a DOS Host, you may
have to change ReachOut’s DOS configuration. You may want to specify a

Choose CAPI if

your ISDN adapter

uses the CAPI 2.0

protocol
Type your

ISDN phone

number here



Chapter 7 •• Configuration

90

nondefault screen size for the DOS Host, or set up background file
transfer. You can also enable Drive Mapping for your computer.

Check ReachOut Help for complete information on the DOS options.

To modify DOS Configuration settings

1. In the Host or Viewer, pull down the Preferences menu.

2. Choose DOS Options.

3. Make your changes in the dialog box, then click OK.

 

To modify advanced DOS options

1. Click Adv. Options in the Host Options section.

2. Make your changes in the dialog box, then click OK.

ReachOut for DOS

To change your COM port configuration under DOS, change to the
ReachOut directory and enter SETUP. You can change any settings for
using ReachOut with a modem, a modem pool, or a direct connection.
You can even define a new modem or edit a modem definition.

To set up for network or modem for the first time, use CONFIG instead.

Set DOS Drive

Mapping

Change DOS

control defaults



Your computer is valuable, and you don’t want just anyone to have
access to it. The best thing you can do to protect your computer from
unauthorized access is to implement strict security measures.

ReachOut comes with a full complement of security measures, some of
which prevent unauthorized users from connecting to a Host. This
chapter focuses mainly on connection security features, which include:

� Passwords to limit Host access

� Intruder Guard to alert you to unsuccessful connection attempts

� Confirmation feature that lets the Host user decide which Viewers
can connect

Other security features allow you to restrict Viewer control over the Host,
disable redirected printing, or force minimum file security when files are
transferred with ReachOut File Manager. File Manager security is
covered in detail in Chapter 5, File Manager.

For system administrators and other users who need more restrictive
security options, ReachOut provides a separate Supervisor Security
utility; the settings here override the Host Security settings. Supervisor
Security is covered in Chapter 9 of this User’s Guide, since its features
are most useful to system administrators.
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Levels of Security

ReachOut provides several levels of security options you can use to
control access to your computer:

� Host Computer Access

� Host Utility Access

� Supervisor Security

Basic Host access includes viewing and controlling the Host, using
ReachOut File Manager, and mapping drives.  Set your general security
options through the ReachOut Host. The Security menu provides basic
control over passwords, ReachOut File Manager access, and the Viewer’s
ability to use features such as redirected printing and remote clipboard
when connected.

If you are in charge of the Host computer, you may want to access
ReachOut utilities on the Host, including the Password List, the Audit
Log, and Share Drives. Defining a master password prevents others from
editing the Host’s passwords and allows you to access the Password List
and other utilities while connected. So if you know the master password,

Host Security

provides basic

control over

passwords and other

security features
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you can use ReachOut to call the Host computer, open the Password List,
and edit it from the Viewer. To learn how to define a master password,
see Master Password later in this chapter.

IMPORTANT! Always close Security and Configuration windows
and dialog boxes when you are finished with them. If you leave them
open, a connected Viewer has access to them even without a master
password.

Passwords

When you require passwords, you secure the Host computer against
users who don’t know a password. With each password entry, you can
specify privileges such as the read/write access allowed to your files and
the Drive Mapping file to use with ReachOut Drive Mapping (see
Chapter 6). Users who connect to the Host cannot run ReachOut Host
utilities such as Configuration and Share Drives. No security features or
password lists can be accessed with a regular password while the Host is
connected.

To require passwords

1. Open the ReachOut Host.

2. From the Security menu, choose Options.

3. Under Passwords Required, choose any setting other

than “No.”

 The number of retries is how many chances a

connecting Viewer has to enter the correct password

before being disconnected by the Host.

4. Choose OK.
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To define a Host password

1. Open the ReachOut Host.

2. Choose Edit Passwords.

3. If passwords have already been defined, choose Add to

add a new password.

 If no passwords have been defined, ReachOut

automatically brings up the Add dialog box.

 

4. Enter a user name.

 All Host user names must be unique. A user name can

be any combination of up to 32 characters.

5. Enter the password.

 Passwords are not case-sensitive, which means that

“Spot” and “SPOT” are the same. A password can be

any combination of up to 16 characters.

6. Choose OK and return to the Host main window to put

the new password into effect.

ReachOut for DOS

Press ENTER after typing or selecting the information in each

field. Only User Name, Password, and File Access need to be

completed; just press ENTER to leave other fields blank. After

the last field on the screen, you will return to the Password

List. Press ESC at any time to exit without saving.
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From the ReachOut Password List dialog box, you can also highlight a
password entry and choose Edit if you want to change an existing
password entry instead.

By default, ReachOut does not require that a connecting Viewer enter a
user name. A supervisor can require user names; see Supervisor
Security in this Chapter 9.

The Password Utility

The ReachOut directory contains a file called PASSWORD.EXE. This is the
ReachOut Password List that is reached from the Edit Passwords button
or the Security menu in the ReachOut Host. If you only want to work
with the Password List, you can run PASSWORD.EXE without opening the
Host.

If you expect passwords to change frequently, you may find it useful to
add PASSWORD.EXE as an icon in Windows Program Manager. On
systems where user names are required, having a Password List icon
makes it easier to change your Host password.

To add ReachOut Password List as an icon

1. In the Windows Program Manager, highlight the

ReachOut group.

2. From the Program Manager’s File menu, choose New.

3. Select Program Item and choose OK.

4. In the Description field, type the name that you want to

appear below the icon; for example, “Password List”.

5. In the Command Line field, type the name of the

password utility, including the full path where it is

stored; for example, “C:\REACHOUT\PASSWORD.EXE”.

6. Choose OK.
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Changing Your Password

Through Supervisor Security, you can allow users to change their own
passwords on a Host computer. Sometimes you will need to change your
password because it is only good for a certain amount of time. Changing
your own password also allows you to keep it secret; not even the system
administrator can view it (although it can still be expired or removed).
You can change your password directly from the Viewer.

To change your password

1. Connect to the Host computer.

2. From the ReachOut Viewer main window, choose

Remote Control.

3. In the viewing window, choose the Password List icon.

 If there is no Password List icon, you can run

PASSWORD.EXE in the ReachOut directory by double-

clicking its name in Windows File Manager.

4. Type your current password and your new password

below it.

5. Choose OK.

The next time you connect to the Host computer, use your new
password.

Password Confirmation

You can add another level of security to Host connections by enabling
ReachOut’s confirmation feature. Suppose several employees are on the
move and routinely call office computers from different places. You can
configure ReachOut so that a person sitting at the Host computer can
confirm or deny connection attempts. When a Viewer attempts to
connect, a prompt appears at the Host asking the Host user to confirm
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that a connection is allowed by that user. If the connecting Viewer does
not enter a user name, then the computer name is used.

When you turn on confirmation, you also set a timeout. When a Viewer
tries to connect, the prompt appears on the Host computer for the
length of the timeout. If the time elapses and no one at the Host
computer has responded, one of two things can happen:

� The Viewer is automatically allowed to connect

� The Viewer is automatically disconnected

You determine which of these options you want by setting Disconnect on
Confirmation Timeout in the Security dialog box.

You can choose to use Confirmation instead of passwords, or you can
have the Host user confirm all attempted connections with passwords.

To turn on confirmation

1. Open the ReachOut Host.

2. From the Security menu, choose Options.

3. Under Confirmation Required, choose anything except

“No.” This field displays the number of seconds for

which the confirmation prompt will appear on the Host’s

screen.

4. To confirm users connecting with passwords, check

Confirm All Passwords.
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5. To have the Viewer be disconnected if and when the

confirmation time runs out, check the Disconnect on

Confirmation Timeout option.

6. Choose OK.

ReachOut for DOS

Choose Confirmation Options from the Security menu and

follow the instructions on the screen.

The Callback Feature

Suppose you work part of your week at home, but you need to use your
computer at the office. You could set up your office PC as a ReachOut
Host and dial in from home. But if it’s a long-distance call and your
company is willing to pay the phone charges, you don’t want the call to
originate from your home. So you have the office PC call back your
home computer, and the phone charges are billed to the office.

This is ReachOut’s callback feature. It tells the Host computer to
automatically call back the Viewer. To use callback, you must define a
callback password on the Host. You can specify the callback number
associated with the password, or have the Viewer enter the callback
number when a connection is established. Using a specific callback
number helps to maintain security by forcing ReachOut to confirm the
source of the call. Using a prompt callback makes it possible to connect
from different locations.

To define a callback password

1. Open the ReachOut Host.

2. Choose Edit Passwords.

3. In the ReachOut Password List dialog box, choose a

password and click the Edit button, or choose Add to add

a new password.



ReachOut for Windows & DOS

99

4. Enter the user name (if necessary) and the password.

5. Under Callback, enter the number that the Host will call

to complete the connection.

 If the connection will be made over a network, enter the

computer name of the Viewer in the Callback field.

 

 To have the caller specify a callback number, type the

word “PROMPT” (all capital letters) in the Callback field.

6. Choose OK and return to the Host main window to put

the new password into effect.

When you connect to a Host using a callback password, the ReachOut
Host automatically hangs up and calls you back. If the callback is set up
to prompt you for the number, you need to enter it before ReachOut can
disconnect and call you back.

Master Password

To use ReachOut utilities such as Supervisor Security and the Share
Drives while connected, you must create a master password for the
Host. With the master password, you can also run the Host’s utilities
from within a viewing window. If a master password exists, you will need
to enter it any time you want to use these utilities—even if you are not
connected.

Enter “PROMPT” in this

field to have the

connecting Viewer give

a callback number
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The master password serves a dual purpose:

� It allows you to run ReachOut utilities such as Share Drives and the
Password List over the ReachOut link.

� It prevents other users from accessing certain security features on
the Host computer, even if they are physically using the Host
computer.

To create a master password

1. Open the ReachOut Host.

2. Choose Edit Passwords.

3. In the ReachOut Password List dialog box, choose Add

to add a new password or Edit to change an existing

one.

4. Type “MASTER” in the User Name field. It is not case-

sensitive.

5. Type the password in the Password field.

6. Choose OK and return to the Host window to put the

master password into effect.

Changing Host Settings Remotely

To set the Host computer’s Drive Mapping and security options remotely,
you must use a master password.

To change settings remotely

1. From the Viewer computer, connect to the Host (using

any valid Host password).

2. From the ReachOut Viewer main window, choose

Remote Control.
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3. In the viewing window, open the ReachOut utility that

you wish to change.

 For example, to change the Host computer’s Supervisor

Security settings, choose Supervisor Security from the

ReachOut group.

4. When prompted, enter the master password.

5. Make your changes and exit the Host’s utility.

 In many cases you will have to disconnect and then

reconnect for the changes to take effect.

ReachOut for DOS

To run the Host’s ReachOut utilities while connected, choose

Return to Host PC from the File menu after you have

connected, then run the Host’s ReachOut utilities.
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This chapter describes how to use ReachOut’s network features. The
information in this chapter is primarily intended for system
administrators. If you simply want to install and run ReachOut on two
computers that are connected to the same network, you do not need to
read on. The network version of ReachOut requires no special
procedures to run. ReachOut’s basic functionality is explained in the first
eight chapters of this User’s Guide.

The power of a network lies in the fact that you can centralize and
control files and applications and still allow multiple users access to
them. ReachOut lets you take advantage of these features. A system
administrator can control configuration and security features at the
highest level, and allow users to set up ReachOut on their computers
from a centralized network directory. For example, you can make
changes in ReachOut’s Supervisor Security on the network and these
settings will be in effect on every computer which runs that copy of
ReachOut.

ReachOut’s network features include:

� “Public” installation of data files from a network directory

� Scripted installation, allowing you to create standard setups

� Centralized security settings, letting you enforce network-wide
security standards

� Gateway support, allowing modem users to access network
computers for telecommuting and other purposes
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Requirements

ReachOut supports five different network protocols:

� Banyan Vines

� FTP’s TCP/IP (DOS and Windows)

� NetBIOS

� NetWare IPX/SPX (SAP or Broadcast)

� Windows Sockets (TCP/IP for Windows)

The Windows Sockets configuration lets you make Windows connections
between computers running on TCP/IP networks. Most versions of
TCP/IP running in Windows are supported by Windows Sockets. For
DOS connections between computers running FTP’s TCP/IP, use the FTP
TCP/IP configuration.

You can also use the Windows Sockets configuration to communicate
with ReachOut over the Internet while running in Windows. To do this,
connect to the Internet using your provider’s software (if you use a
modem), then run ReachOut configured for a Windows Sockets
connection. If you are already on a network, you won’t have to connect
directly to the Internet first. You will need to know the IP address of the
computer that you want to connect to.

When you are running in DOS, each network type has an associated
executable file that controls the ReachOut interface. This executable is a
Terminate-and-Stay-Resident program; once it is loaded, ReachOut can
be used to link any two computers on the network. The users need not
be logged on to a network server to make a ReachOut connection. To
link computers on different types of networks, you must use a gateway.
See ReachOut Gateways later in this chapter.

For specific information on using ReachOut with the different network
types, see Network Technical Information at the end of this chapter.



ReachOut for Windows & DOS

105

Installation and Setup

ReachOut installation is covered in Chapter 2 of this User’s Guide. When
you reach the Connection Type dialog box, choose Network; then select
your network type.

General configuration is covered in Chapter 7. The advanced
configuration options are different for each network type. ReachOut
provides default values for any required parameters; others are left
blank. Note that a NetWare server name is required only if you want
ReachOut to communicate between network segments.

For details on the specific settings, see ReachOut Help.

Changing the Connection Type

If a computer is on more than one network, or if you use both network
and modem connections, you may want to change the type of connection
that ReachOut is using. You can do this at any time with the
Configuration utility.

To choose a different network

1. Choose Configuration from the ReachOut program

group.

2. Choose Network, Internet, or Remote Node from the list

of connection types.

3. For Network or Remote Node connections, select the

network type from the Communications drop-down list.

 If you choose Internet, ReachOut is automatically

configured for Windows Sockets.

4. Choose OK.
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ReachOut for DOS

To choose a different configuration, change to the ReachOut

directory and type CONFIG, then press ENTER to set up

ReachOut for DOS.

Installing Over the Network

Instead of having an independent copy of ReachOut running on each
network computer, you can centralize and control ReachOut by
installing it onto a network drive. Users can then run ReachOut from the
network directory, installing only individual data files and batch files to
their own computers. Install’s PUBLIC parameter does this automatically.

To install only ReachOut data files

• Change to the network ReachOut directory and type

INSTALL PUBLIC.

If users install from a network directory, you can make security settings
globally. For details on securing ReachOut on a network, see Supervisor
Security later in this chapter.

Scripted Installation

If you want to install ReachOut on many different computers, you can
use a script to determine all the settings so that you do not have to go
through all the screens every time you install the program. This allows a
network administrator to preconfigure the installation for users. If you
fully install ReachOut on a network drive, then INSTALL.EXE can be run
on each workstation directly from the network. You can attach a script
file to INSTALL.EXE so that ReachOut skips some or all of the setup
questions. For example, if you want the computers configured only as
Viewers, put the line TYPE=VIEWER in the script file.
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To create an installation script

1. Using any text editor, such as Windows Notepad or DOS

Edit, create a new file.

2. On separate lines, type the installation keywords and

their settings.

3. Save the file in the ReachOut directory.

To make installation transparent to the user, you may want to bypass all
of ReachOut’s installation dialog boxes by specifying the options in the
script file. Here are some of the features you can set in the script file:

To do this ... Type this line ...

Install only ReachOut data files
and batch files

PUBLIC

Install ReachOut to a specific
directory

TARGET=path_name

Specify a directory under which
a user can install to any
subdirectory

TARGET=path_name\%1

Configure as a Host only TYPE=Host

Configure as a Viewer only TYPE=Viewer

Configure as both a Host and a
Viewer

TYPE=Both

Configure for Windows only MODE=Windows

Configure for Network only NOMODEM

Set the network type NETWORK=network_protocol
(Types: NetBIOS, SPX, IPX, Banyan,
SAP, FTP, WinSock)
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To do this ... Type this line ...

Set the computer name NAME=computer_name

Allow the user to type the
computer name with the install
command (example: INSTALL
NEWPENTIUM)

NAME=%1

Set the NetWare server SERVER=server_name

Specify no NetWare server SERVER=

Use the scripted install
parameters without letting the
user confirm them

AUTO

Full explanations of the installation script commands can be found in
Appendix B.

To run an installation script

• Type the name of the script file after the word INSTALL.

 For example, if the script file is called NOW, change to

the ReachOut directory and type INSTALL NOW.

Tip! ReachOut’s default script file name is ROINST (with no file
extension). If you create an installation script with the name ROINST
and save it to the ReachOut directory, it automatically executes when
you run ReachOut’s INSTALL.EXE from DOS or from Windows.

Connecting on the Network

When you connect over a network using ReachOut, the ReachOut
Connect dialog box prompts you for the name of another ReachOut
computer. You create a network phone book just as you would create a
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modem phone book, using the Add, Delete, and Edit buttons. Just enter
the ReachOut network computer name instead of a phone number.
Managing the Phone Book in Chapter 4 covers the details.

There is also an option to display the names of all of the available
ReachOut Hosts.

Note: Because this option searches the entire network and provides
a list of every ReachOut Host available, it can be time-consuming and
will increase network traffic. It is recommended that you do not use it
unless you actually need it.

To display all available ReachOut Hosts

• In the ReachOut Connect dialog box, check the box

labeled Show List of Available Network Names.

ReachOut updates the list every few seconds while the dialog box
remains open. If a particular Host computer is already connected to a
ReachOut Viewer, you’ll see the word “Busy” in the Status column for
that entry. To connect, choose a computer from the list or type it’s name
in the Network Name field. Then connect as explained in Chapter 3.

Note: Show List of Available Network Names is not available on
TCP/IP based networks (ReachOut’s FTP and WinSock configurations).

Check this

box to

display a list

of available

network

Hosts

ReachOut displays

a list of network

computer names



Chapter 9 •• Network Operation

110

Supervisor Security

If you are a system administrator, you may want to have more control
over the security of a Host computer. In addition to Host Security,
ReachOut provides a more extensive Supervisor Security program for
use by system administrators. You can use Supervisor Security to:

� Set security options that are not available from the ReachOut Host

� Override security options that are available from the ReachOut Host

� Enforce consistent security measures on all network Hosts

For example, you could use Supervisor Security to prevent access by
users running older versions of ReachOut. Or you could permanently
disable print redirection so that Viewer users cannot turn it on. Other
supervisor options are described below.

To enforce Supervisor Security settings on all Host computers, each
workstation must do a “public” installation of ReachOut from a secure
network directory; refer to Installation and Setup earlier in this
chapter. Any settings that you do not override can still be configured on
the Host computers.

The figure shows the ReachOut Supervisor Security window, and this
section outlines some of the main features of ReachOut’s Supervisor
Security. For full details about specific security options, click Help.
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Passwords and User Names

The password options are various restrictions on the use of passwords.
You can set limits on the password life, invalid connection attempts, and
the use of repeated passwords, among others. Most of these options are
not available through the main Host security.

You can also use Supervisor Security to require user names.

To require user names

1. Click the Password button, or choose Passwords from

the Display menu.

2. Check User Name Required for Logon.

Note: A user name is not the same as the computer name that you
give when you install or configure ReachOut. A person who has a valid
user name and password can connect from any computer that has
ReachOut installed.

The Password section of Supervisor Security also allows you to enforce a
standardized callback procedure.

To do this ... Check this option ...

Invalidate all Host passwords
without callbacks

Callback to Viewer Required

Invalidate all Host passwords with
prompt callbacks

Disallow Prompt for Callback
Number

Password Confirmation

You can set password confirmation from Supervisor Security. If you
enable confirmation, it cannot be disabled in Host Security. You can
require password confirmation but leave the disconnect and timeout
options up to the Host user.
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To allow the Host user to set the timeout

1. Click the Confirm button, or choose Confirmation from

the Display menu.

2. Type “0” in the Confirmation Timeout field.

 The field display will show “User Defined” the next time

you open Supervisor Security.

Any other number displayed in Confirmation Timeout specifies the
length of the timeout in seconds.

Auditing Connections

With the auditing options you can keep track of all ReachOut
connections, whether the computer is a Host or a Viewer. You also have
the option of monitoring any file transfers that occur using ReachOut
File Manager. Auditing information is saved in a file called an audit log.

For information on using the audit log, see Chapter 4, Remote Control.

Intruder Guard

The Intruder Guard triggers an error on the Host computer if too many
invalid connection attempts are made in a row. To set the Intruder Guard
options, click the Security button at the bottom of the Supervisor
Security window. You can set two types of Intruder Guards:

� Global Intruder Guard

� Individual Intruder Guard

If you define a global Intruder Guard, it is triggered when the maximum
number of consecutive connection attempts has been reached, no matter
who tries to connect. Once the global Intruder Guard is activated, no
Viewer can connect to the Host until the Intruder Guard has been reset.
Someone must physically be at the Host computer to reset the Intruder
Guard.
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The individual Intruder Guard is triggered when the unsuccessful
connection attempts are made from the same phone number or network
computer. ReachOut sends a message informing the Viewer that the
maximum number of connection attempts has been exceeded.

If you just set the individual but not the global Intruder Guard, the global
Intruder Guard may be turned on in Host Security.

Note: The number of invalid connection attempts is the number of
times that the Intruder Guard will not be triggered. For example, if you
set the global or individual Intruder Guard to 2, then two consecutive
invalid connection attempts are allowed. After the third unsuccessful
attempt, the Intruder Guard is triggered.

Viewer and Host Restrictions

The general Security dialog box also provides a number of options that
restrict the tasks you can perform from either the Viewer or the Host
computer. For example, you can choose to blank the display on the Host
screen whenever the Host is connected. You can also choose to prevent
the Viewer from redirecting print jobs from applications on the Host
computer to a printer connected to the Viewer. If you enable an option
in Supervisor Security, it cannot be changed in Host Security.

Suppose you want to use the Host computer as a file server, similar to a
network server. You could disable the Viewer input and restrict the files
accessed through ReachOut File Manager. The Viewer would then have
access only to the Drive Mapping ServeUp paths you defined on the Host.

Additional details about Host and Viewer restrictions can be found in
ReachOut Help.
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Enforcing Security Settings

When users run ReachOut from the network directory, the Supervisor
Security settings take effect on each computer. ReachOut creates a coded
file called REACHOUT.SEC that contains all of the Supervisor Security
settings. This file cannot be edited without SECURITY.EXE.

To enforce ReachOut security settings

1. Run Supervisor Security and make any security changes.

2. In the ReachOut directory, create a script file named

ROINST and enter the keyword PUBLIC on a line by

itself. (See Scripted Installation earlier in this chapter.)

3. Make the ReachOut directory read and file-scan only.

Centralizing Passwords

You can force passwords to be read from the shared ReachOut directory.
This allows the supervisor to have control of all passwords for any
session of ReachOut run from the network; users will not be able to
create or edit passwords.

To prevent individual password directories

1. From the ReachOut network directory, run the Password

List (PASSWORD.EXE).

2. Create a password entry for each user who will run

ReachOut from the shared directory.

3. Exit the Password List, and open Supervisor Security.

4. In the Password section of Supervisor Security, check

Use Supervisor Directory for Passwords.
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ReachOut Gateways

Many times it is convenient for an employee to be able to access an
office computer from home. Since most people do not have their home
computers linked to the office network, this requires using a modem.

But this does not mean you have to install a modem on every office
computer. A ReachOut gateway provides a way to connect a Modem
Viewer with a Network Host. You do this by using a bridge computer,
which transfers data between the two. The bridge is a network computer
set up to receive a ReachOut call over a modem. A modem user
connects to the bridge’s Modem Host and uses the bridge’s Network
Viewer to call any ReachOut Host on the network. If the bridge computer
maintains an audit log, it records all ReachOut connections to the
network.

You can also set up a gateway between two different networks, if the
bridge computer has network cards installed for both. You can only set
up a ReachOut gateway between computers running ReachOut over
different types of connections. The bridge computer cannot
simultaneously run Modem Host and the Modem Viewer, or the Host and
the Viewer for the same type of network.

Only one caller can use the bridge at one time. If you expect many
ReachOut calls to the network, you may want to set up more than one
bridge computer so that multiple users can be connected at the same

Example of a ReachOut

gateway configuration
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time. You can set up your phone lines in a “Hunt group” so that they are
all serviced by the same phone number. Your telecommunications
manager should know how to do this.

Tip! You should probably configure your Hunt group in a
“rotational” manner rather than a “linear” one. This means you route
incoming calls to each computer in turn, instead of always checking
the first one. The advantage is that if something goes wrong with the
first computer, callers can still connect to another one.

Setting Up the Bridge Computer

ReachOut’s DOS Host and Viewer automatically negotiate a gateway
configuration. For basic setup, you need only run the Host and the
Viewer at the same time.

IMPORTANT! ReachOut gateways can only be configured using
the DOS Host and the DOS Viewer. You must exit Windows completely
before you can set up a gateway. However, you can connect to or from
the bridge using a computer that is running ReachOut for Windows.

Configuring the Bridge as a Host

To ensure that a gateway configuration remains in place after each user
disconnects, you will want to add the Host command to the bridge
computer’s AUTOEXEC.BAT file, and have the bridge computer restart
after each use.

To configure a bridge computer as a Host

1. If you are in Windows, choose Exit Windows from the

Program Manager’s File menu to return to DOS. You

cannot use a gateway from a DOS prompt within

Windows.
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2. Change to the ReachOut directory, then type HOST and

press ENTER to run the ReachOut Host.

3. Press ALT+RIGHTSHIFT to open the Host screen.

4. From the Security menu, choose Reboot Upon

Disconnect, then choose “Immediately” or “After 5

Minutes.”

 You can also change this setting in Supervisor Security.

5. Exit the Host and edit the computer’s AUTOEXEC.BAT.

6. On a line by itself, type the command to change to the

ReachOut directory; for example,

 CD C:\REACHOUT

7. On the next line, type the command to run the

appropriate ReachOut Host batch file: GHM.BAT for

modem or GHN.BAT for network; for example,

 CALL GHM

 IMPORTANT! Do not combine steps 6 and 7 to use CALL
C:\REACHOUT\GHM. The batch file needs to be run from the
ReachOut directory or it will not find the license information and
will therefore fail to run.

8. Save AUTOEXEC.BAT.

Configuring the Bridge as a Viewer

When you connect using a ReachOut gateway, you actually connect to
two separate computers, each with its own ReachOut configuration and
security. The bridge computer can have one password while each
network computer has its own separate password. For security reasons,
you can require that a user type a password for each computer. Or you
can bypass the second logon so the bridge automatically connects to a
network computer.
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There are several different strategies you can use:

� Have the ReachOut Viewer automatically open on the bridge

� Have the bridge automatically connect to a network Host

� Have the bridge present a lists of different Hosts to connect to

To have the ReachOut Viewer open

• Edit the bridge computer’s AUTOEXEC.BAT to include a

line that calls the Viewer batch file GVN.BAT. This line

must come after the line that calls the Host.

If each user will always connect to one particular network Host, you can
set up the bridge computer so that it automatically connects to that Host.
To do this, create a command file and attach it to the user’s password.
When the user connects to the bridge, the command file automatically
runs. This method also has the advantage of automatically disconnecting
the bridge computer when the user disconnects from the Host.

To have the bridge automatically call a
network Host

Create a command file

1. Using any text editor, create a ReachOut command file.

This file must have the extension .CMD.

2. Type CD C:\REACHOUT to have the Host change to the

ReachOut directory.

3. Type GVN computer_name.

 For example, if the name of the Host is TEST, type GVN

TEST. Be sure to use the ReachOut computer name, not

the one assigned by the network.

4. Save the command file in the ReachOut directory.
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Attach the command file to a password entry

5. Using the PASSWORD utility, enter the name of the

command file in the user’s password entry. (The

Command File field is in the Password Advanced

Options; press F10 when you reach the Password Entry

screen. See Command Files in Appendix B for details.)

Have the Viewer run the command file

6. In the ReachOut directory, edit GVN.BAT.

 You could also create a new batch file for starting the

ReachOut Viewer.

7. Locate the line that contains the word VIEWNET.

8. Add   /NAME=%1  to the end of the line; for example,

 C:\REACHOUT\VIEWNET /NAME=%1

9. Save GVN.BAT.

When a Viewer uses this password to connect to the bridge computer,
the bridge automatically calls the Host specified in the command file.

Instead of automatically connecting a Viewer to one particular Host, you
can create a simple batch file that gives callers a menu when they reach
the bridge. For example, the following batch file presents the user with a
list of network computers that the bridge can connect to:

echo off
cls
echo Network Hosts:
echo.
echo 1. Engineering Main
echo 2. Bob’s Office
echo 3. Carol’s Office
echo.
echo.
prompt Type a number (1-3) and press ENTER:
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One of three files 1.BAT, 2.BAT, or 3.BAT automatically changes to the
ReachOut directory, runs the Network Viewer, and connects to the
appropriate Host. Set up each batch file the same way you would set up a
command file, as described in the previous procedure. (If you use the
example above as a menu, you may want to put the line PROMPT=$P$G
at the top of each numbered batch file to reset the DOS prompt.)

To display the menu when the bridge restarts

• Add the batch file name to the end of the bridge

computer’s AUTOEXEC.BAT.

 For example, you can name the above file MENU.BAT

and add the line

 CALL MENU

 to the end of the bridge computer’s AUTOEXEC.BAT.

The following is an example of a bridge computer’s AUTOEXEC.BAT file
before and after configuring a gateway:

Before ... After ...

prompt $p$g prompt $p$g

lsl lsl

exp16odi exp16odi

ipxodi ipxodi

netx netx

PATH=C:\WINDOWS;C:\DOS;C:\ PATH=C:\WINDOWS;C:\DOS;C:\

lmouse lmouse

cd C:\REACHOUT

call GHM
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call MENU

Disconnecting Gateways

When you are finished using the gateway, you should always disconnect
“cleanly” from both the Host computer and the bridge. This means using
the File menu in the ReachOut Viewer. If you hang up your modem
without exiting ReachOut, the bridge and the Host may still be
connected.

You can set an inactivity timeout on each network Host in case a gateway
connection is accidentally interrupted. Then if no data is being
transmitted, ReachOut will disconnect the Host after the specified time
has elapsed.

To set an inactivity timeout

1. On the Host computer, change to the ReachOut directory

and start the Host. Use ALT+RIGHTSHIFT to display the Host

screen.

2. From the Preferences menu, choose Inactivity Timeout.

3. Choose an appropriate length of time from the

secondary menu.

 If you expect the gateway to be used often, you should

choose “5 Minutes.”

Network Technical Information

This section contains technical information that may be useful when
running ReachOut on a network. See Appendix A for troubleshooting
information.

For NetWare and Banyan protocols, ReachOut provides each computer
with two 6-character strings, one for the broadcast ID and one for the
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group ID. The broadcast ID is used by ReachOut to identify the
computer in broadcast network communications. The default broadcast
ID is “OCEANI.”

The default group ID is “RCHOUT.” You should only change it if you
want to separate groups of ReachOut computers. ReachOut can only
communicate with computers that have the same ReachOut group ID.

Novell NetWare

ReachOut runs with any version of NetWare, including Personal NetWare.
In Broadcast mode, ReachOut can communicate directly with IPX when
configured for a NetWare IPX/SPX connection, or it can communicate
with NetWare’s NetBIOS emulator using the NetBIOS configuration.

To operate correctly in NetWare Broadcast mode, ReachOut needs only
the file IPX.COM, or the three files LSL.COM, a Network interface card
driver such as NE2000.COM or EXP16ODI.COM, and IPXODI.COM—
which allow ReachOut to perform peer-to-peer communications with
other IPX workstations on the network. To connect across different
network segments in Broadcast mode, you need to be running a shell
(usually NETX or VLM) and be attached to a file server. On the Viewer
computer, you must also specify a server name in NetWare Advanced
Settings. To use the SAP configuration, you need to be running a shell.

ReachOut cannot function as a Host or a Viewer on a NetWare file server.

Banyan VINES

You do not have to have the Banyan redirector loaded to use ReachOut.

ReachOut uses its own naming mechanism to make a connection from a
Viewer to a Host. The StreetTalk naming function of Banyan VINES is
only used if no computer name is specified for ReachOut. Then
ReachOut uses the part of the StreetTalk name before the first @ symbol,
to a maximum of 15 characters.
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ReachOut’s Banyan VINES socket support can function across your Wide
Area Network (WAN). ReachOut has been successfully tested on Banyan
9.6K, 19.2K, and 56K baud Wide Area Network links. When using
ReachOut across these slower links, have Windows disk caching
enabled. This is set under Viewer Options on the Preferences menu in
the ReachOut Viewer.

NetBIOS

ReachOut provides a NetBIOS programming interface for accessing
many network environments (RCHNETB.EXE).

If you are using LAN Manager, you must be running version 2.0 or
greater. ReachOut works with the BASIC or the ENHANCED workstation
software. The computer name configured by LAN Manager is also the
ReachOut computer name. The NET START WORKSTATION command
registers the computer name with NetBIOS. If this command is not
executed, ReachOut requires the NAME= parameter on the
RCHNETB.EXE command line. Refer to Appendix B for information on
ReachOut command line switches.

For Further Assistance

You can order technical documents directly from Stac. Use Stac’s
Bulletin Board System to download technical notes; the Stac BBS is
included as an entry in the ReachOut modem phone book. You can also
call Stac Fax to have documents faxed to you. Look in the front of this
User’s Guide to find the phone number.

Files, including technical notes, are also available for downloading from
our World Wide Web page on the Internet.
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If you have any problems connecting with or using ReachOut, refer to
this appendix before you contact product support. The information in
this appendix will help you solve problems that may occur.

� Modem Troubleshooting

� Direct Connect Troubleshooting

� Network Troubleshooting

� Modem Pool Troubleshooting

� Mouse Troubleshooting

� Redirecting Printing

� Video Resolution

� DOS Graphics Don’t Display
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Modem Troubleshooting

If you have any problems getting connected and staying connected over a
modem, check this appendix. You should be able to find the problem
and solve it quickly. If you use Modem Pool software, check with your
system administrator first to be sure you are loading the correct TSR and
specifying a valid modem. Then continue with this appendix.

The appendix includes procedures for identifying where the problem
may be as well as detailed steps for checking out various pieces of your
system. The first step is to determine exactly where the system breaks
down:

� ReachOut can’t dial the modem

� Incoming call rings, but the modem does not answer

� ReachOut dials, but nothing answers

� A modem tries to answer, but no valid connection is made

� ReachOut connects, but loses the connection quickly.

� ReachOut connects, but not under the conditions you want

Once you identify where the problem occurs, you can investigate in
more detail. This appendix includes suggestions for localizing,
identifying, and fixing problems. Take time to try one thing at a time.

ReachOut Can’t Dial or Answer the
Modem

Any internal or external modem connection involves several physical
components. Of course, each computer needs a modem, a telephone
line, and appropriate cables. The computer needs a serial port, often
called a COM port. The COM port includes a UART chip that controls the
maximum speed at which the port can transmit and receive data. The
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COM port is also assigned to an IRQ (Interrupt Request). Any one of
these can cause problems.

If you can successfully make modem connections outside of ReachOut
with the same physical equipment, check for IRQ conflicts first.
ReachOut needs an isolated IRQ to make a connection.

Modem Pool.  Modem pools require that you run a TSR, or Windows
driver, before connecting with a modem accessed from the pool. Check
your modem pool documentation or see your system administrator for
details. Once the modem pool’s TSR, or driver, is loaded, you should be
able to connect. Some modem pool software includes monitor programs
to help you make connections.

Telephone Line

The telephone line at each end of the connection must be active. If you
have made voice calls or used your modem on that line before, it is
probably fine. If not, make sure the telephone cable is attached to the
correct jacks in the right order. If you have an internal modem, the cable
goes from the  wall telephone jack to the computer. If you have an
external modem, the cable goes from the  wall telephone jack to the
modem.

If your modem has two jacks, the cable should be plugged into the jack
labeled LINE or TELCO,  NOT the one labeled PHONE.

To check the telephone line

• Plug a voice telephone into the wall jack to make sure

you get a dial tone. Call the Host and see if you get a

modem tone.
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Cables

External modems require a serial cable  plugged into the correct outlets
on both the modem and the computer. Check your modem
documentation if you aren’t sure. Serial cables are usually plugged into
COM1 or COM2. PCMCIA and internal modems do not require a cable.

To ignore a carrier signal

• Under Windows, start the Host or Viewer if necessary. Then choose
Configure Connection Type from the Preferences menu. Click the
Advanced Settings button, then choose Ignore  in the Carrier field.

ReachOut for DOS

Type SETUP to start the configuration utility. From the Comm Settings
menu, choose Advanced Comm Options. Then choose Ignore Carrier
from the Carrier Control submenu.

Modem

Make sure a modem is attached correctly to each computer. A serial
modem cable must connect an external modem to a serial (COM) port
on the computer. Don’t use a null modem or serial printer cable.

� Each modem must be defined and configured correctly in
ReachOut.

� Each modem must be turned on and properly connected to the
communications (COM) port specified in ReachOut for that
computer.

To identify the modem

• For an external modem, check its permanent label.

• For an internal modem, check its documentation.
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If your modem was listed in the modem list and you chose the exact
modem, it is probably configured correctly. If your exact modem isn’t
listed, choose A Hayes Compatible 2400 modem. Then set the baud rate
to the transmission speed your system can handle.  Modems capable of
compression can be set to speeds (baud) higher than the modem’s
baud. For example, you can set a 14400 baud modem to 19,200 baud.
Most 2400 baud modems should be left at 2400 baud.

The modem cannot share an IRQ with another device. See IRQ Conflicts
later in this section.

To define a generic modem in ReachOut for
Windows

1. In Windows, open the ReachOut Viewer.

2. From the Preferences menu, make sure Modem is

selected. Then choose Configure Connection Type.

3. If necessary, enter the master password.

4. In the Configuration window, open the Modem drop-

down list and choose A Hayes Compatible 2400.

5. Close the Configuration window.

6. From the Link menu, choose Modem Diagnostics.

 If the second line shows OK, the generic modem is

communicating with ReachOut. Now you want to use the

highest possible speed. In the gray area, notice what

UART chip is used.

7. Return to the ReachOut Viewer.

8. From the Preferences menu, choose Configure

Connection Type.

 

 



Appendix A •• Troubleshooting

130

9. Set the speed to match your UART chip (19,200 for UART

8250 or 38,400 for UART 16550).

 If your modem is actually a 2400 baud modem, set the

speed at 2400 baud.

10. Check Modem Diagnostics again. If you still see OK, try

using ReachOut over the modem you have just defined.

ReachOut for DOS

In DOS, run SETUP to select a modem. Start the Viewer, and choose
Modem Diagnostics from the Link menu to see if OK is displayed after
the reset string. If an ERROR is displayed, you probably have not
selected the correct COM port.

To identify the COM port

1. Make sure the speaker for the modem or computer is on.

Check your modem documentation if necessary.

2. At a DOS prompt, type ECHO ATH1>COM1 and press

ENTER.

� If you hear a dial tone, you have found the serial port for your
modem. Type ECHO ATH0>COM1 and press ENTER to turn it off.

� If you don’t hear a dial tone or if you get any kind of error
message, you have not found the right port. Repeat step 2 for
COM2, COM3, and COM4.

You can run the same test with the modem plugged into the computer
and the wall telephone jack, then a voice telephone plugged into the
modem. Pick up the handset and listen to the dial tone. When you find
the right port, you’ll hear a click or the phone might seem to go dead.

You can also use modem diagnostics to see if you have configured the
correct COM port. (In Windows, choose it from the Link menu. In DOS,
type RCHMDIAG at the DOS prompt.) If you see just a flashing cursor in
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the text area, the COM port is probably wrong. Change it and check
modem diagnostics again.

If you can’t find the COM port, you may have a hardware problem.
Check your computer documentation or contact the manufacturer.

IRQ Conflicts

DOS and Windows let different functions share IRQs, but ReachOut
requires that the serial port be independent. By default, COM 1 and
COM 3 often share an IRQ, as do COM 2 and COM 4. If you have only
two COM ports and an external modem, you won’t have this problem.
However, some network  adapters may also share an IRQ with a serial
port.

Many internal modems are configured, by default, to use COM 2 on
IRQ 3. This causes a conflict with a previously existing COM 2, whether
the device is in use or not. Refer to your modem’s manual to change the
COM and IRQ settings, or disable your computers COM 2. COM ports on
most serial cards are set by jumpers on the card. Refer to your
computer’s documentation for details on changing it.

To check for IRQ conflicts

1. If necessary, exit to DOS.

2. At the DOS prompt, type MSD and press ENTER. (If

necessary, change to the DOS directory.)

3. Type Q to see the IRQ (Interrupt Request) information.

4. Locate the COM port your modem uses and see the

number of the IRQ. Typically IRQ 3 and IRQ 4 are used

for all the COM ports.
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5. If your modem’s COM port shares an IRQ with another

device, notice what COM ports are detected and what

other IRQs are available. IRQ 5 is frequently not

assigned, for example.

 If you have only two serial devices, you can assign one

to COM 1 and one to COM 2. If you have three serial

devices, you’ll have to change the IRQ assignment of

one of the ports.

Nonstandard IRQ

If you aren’t able to start up the Host or start a connection with the
Viewer, you may see a message that the “communications port is not
available.” This may occur if your modem’s COM port uses a
nonstandard IRQ. This process is required for internal modems set to
COM 3 using IRQ 5.

To change it, open the Windows Control Panel. Click the Ports icon and
select the COM port your modem uses. Click Settings, then Advanced
Settings.

Change the Interrupt Request Line (IRQ) field to show the interrupt your
modem is actually set to. After making the changes in Control Panel, exit
Windows and try ReachOut again.

Dial, But No Answer

Sometimes you can tell that ReachOut is dialing, but it doesn’t make a
connection. If the line is busy or out of order, try again a bit later. If your
modem doesn’t get an answer, try one of these:

� Make sure the phone number is correct.
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� Try calling the Stac BBS to verify that your basic configuration is OK,
then try your own connection again. The Stac BBS is already
included in your phone book. You may have to modify the number
by adding 9 to the beginning of it (if your phone system requires
that you dial 9 first) or removing the area code (if you are in the
area code listed).

 If the BBS connects, your Viewer’s modem is functioning. To verify
your Host, exit the Host menu, start the Viewer menu, and connect
this machine to the BBS also.

� If you were using Windows, try the original connection in DOS. Try
the BBS under DOS, too. Here’s how:

1. Close Windows and exit to DOS.

2. Change to the ReachOut directory and type VIEW.

3. Use the Link menu to try to connect using ReachOut

for DOS.

� Make sure your modem is defined correctly. If there is any question,
define a generic modem (explained earlier in this Appendix) and
try connecting with that.

Attempted Answer, No Connection

You can tell when ReachOut tries to connect. You may hear different
noises. You may see dialog boxes or prompts on the Viewer screen. Here
are some things to check if this happens to you:

� Are you using the correct values? In addition to the correct phone
number, the Host may require a password and maybe even a user
name. If the Host uses a callback number, make sure it uses the
telephone number of the line attached to your modem.

 If you aren’t absolutely sure, check and try again. You might try
calling the number with a standard telephone to see if you get an
electronic tone.
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� Does ReachOut have enough time to connect?

 The default is usually plenty. If you have an involved connection,
such as starting at 2400 and switching to 14400, or establishing an
international connection, ReachOut may need more time. In
Windows, configure the Dial Timeout or CTS Timeout field. If you
can’t connect under DOS, you can add the CTSTMO parameter to
your RCHSRL communications driver line. See Appendix B for more
information on DOS command line parameters.

You can also change your modem’s S7 register.

To set the S7 register

1. Double-click the Configuration icon.

2. Choose Modem, then click the Advanced Settings

button.

3. In the Prefix field, change the dialing prefix from

ATDT to AT S7=255 DT. This will increase the

modem’s time-out.

4. If you prefer to change your modem’s reset string,

click the Modem Config button. Choose your modem

and click Edit. Then add S7=255 just before the final

carriage return symbol.

� Is the transmission speed correct?

The real limiting factor on speed is the UART in your computer. The
UART chip determines how fast your computer can reliably transmit
data to the modem.

 UART  Maximum speed
  8250 19,200 bits per second
16550 38,400 bits per second

If you have a very high speed internal modem or an accelerator
card (such as Hayes ESP), you can get even more throughput. These
are maximum values, however. The speed of your computer and the
modem’s rated speed also influence what you can get.
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Connection Not Maintained

ReachOut may be able to connect some or all of the time, but have
trouble maintaining a connection. Here are the usual causes:

� Your transmission speed may be too high.

 If you specify too high a speed, you’ll get lots of errors, which you
can see in the modem diagnostics in Windows. And when too many
errors occur, ReachOut may lose the connection. Try lowering the
baud rate to the next lower number.

- Under Windows, use Configure Connection Type in either the
Host or Viewer Preferences menu, then change the Baud field.

- Under DOS, type SETUP, then choose Data Speed from the
Comm Settings menu.

� Your telephone line may have excessive noise.

 Try configuring ReachOut to use a slower speed on your modem.

 Make the connection again later. Line noise is erratic and the
connection may hold fine in a few hours.

� Your COM port may be sharing an IRQ.

 See IRQ Conflicts earlier in this Appendix.

� Hardware flow control

If the flow control is set differently at both ends, the modems will
connect, but disconnect within a few seconds. ReachOut only works
with CTS/RTS (Hardware) flow control. You may have to change
your modem’s reset string to enable hardware flow control. See the
modem diagnostic online help for details.

Connection Not as Desired

After doing a bit of troubleshooting, you may find that you can connect
to the Stac BBS or other systems in the ReachOut Terminal Emulator, but
you can’t connect to a ReachOut Host. Or you may find that you can
connect under DOS, but not under Windows. Or you may find that you
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can maintain a connection at 2400 baud but not at a higher rate. Here
are some suggestions:

If you connect in Terminal mode but don’t see
a ReachOut Host:

� Verify the following for both Host and Viewer:

- Modem’s COM port and IRQ. Be sure the IRQ is not being
shared with any other device.

- Transmission speed (baud). See the UART section above for
maximum speed settings.

� Use modem diagnostics to verify that an OK is displayed after the
reset string.

� Try the connection with both computers in DOS. Run GVM on the
Viewer, GHM on the Host.

If you connect under DOS but not Windows:

� The problem may be with your modem definition. ReachOut for
Windows requires a precise modem definition. For example,
suppose you have an external 9600 baud modem that isn’t in the
list. However, an internal one with a similar name from the same
manufacturer is listed. If you choose the listed internal modem, the
external modem will work fine with ReachOut under DOS. However
if your modem does not appear on the list, select A Hayes
Compatible 2400. Try a connection; if successful, increase your
baud to 9600. Try connecting again; if successful, increase your
baud to 19,200.

� Occasionally, two modems of different brands and speeds won’t
communicate well. They may work fine under DOS, but not with the
additional overhead of Windows. Try another modem on one end if
possible.
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� You may have Windows memory conflicts. Try adding the line
Emmexclude=A000-FFFF in the [386Enh] section of SYSTEM.INI to
see if you have any upper memory problems. If you can connect
under DOS, you can narrow down the memory exclusion.

If you can use ReachOut at a slow speed but
not at or above your modem’s rated speed:

� You may not be using all your modem’s features. This can happen if
you defined a generic modem because yours wasn't on the list. You
can get an up-to-date list from the Stac BBS. Just download
MTABLE.EXE. When you run MTABLE, the result is MTABLE.RCH,
the latest version of the modem list. You can copy this into your
ReachOut directory and see if your modem is listed now. One
caution though: if you edited any of the modem definitions earlier,
replacing MTABLE.RCH overwrites your changes.

� Your transmission speed may be limited by the UART chip. See the
UART table earlier in this appendix.

� Occasionally, two modems of different brands and speeds won’t
communicate well. Try another modem on one end if possible.

Direct Connect Troubleshooting

If you can’t connect directly, first check these things:

� Is Direct Connect Cable the selected connection type on each
computer?

� Are they connected by a null modem serial cable? This is not the
same as a standard serial cable, such as one you might use for a
modem or serial printer. Most null modem cables include a DTR
line; if yours doesn’t, try a different cable.

� Set the baud the same on both Host and Viewer.
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� Is each end of the null modem cable plugged into a COM port and is
ReachOut configured to use that COM port? The COM port cannot
be shared with any other device and it must have a unique IRQ. Use
MSD under DOS to check the use of your COM ports and IRQs.

Network Troubleshooting

Both the Host and Viewer computers must be connected to the
configured network and it must be running in order to make a
connection.

When you configured ReachOut to use the network, be sure the network
you chose is compatible with the one you use. For example, if you have
Windows for Workgroups, make sure you chose the network that is
actually in use. The MS-NET built into Windows for Workgroups uses
NetBIOS, but your network may actually be NetWare IPX/SPX or even
Window Sockets. If you have Windows for Workgroups, you can check
the Network Setup icon in the Network program group to see which
network is being used. If you can’t determine it, see your network
administrator.

If network list doesn’t show an available Host:

� Your List Request Timeout may be too short, so ReachOut doesn't
have time to scan the entire network. Use the Configuration
program to specify a longer time.

� The Host you are looking for may not be active. ReachOut lists only
the Hosts that are currently waiting for a connection.

� If you are using NetWare IPX/SPX or Banyan VINES network, your
computer may have a Group ID or a Broadcast ID specified.
ReachOut won’t list any Hosts that don’t have that same Group ID
and Broadcast ID.
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� For NetWare IPX/SPX, you may not have specified a file server.
ReachOut scans only the local segment or network number unless
you specify a server. If you specify any server on the net, ReachOut
can search all servers for available Hosts and connect to any of
them. You may want to specify a server close to the Host in a very
large system.

� Your network may not support this feature. For example, TCP/IP
doesn’t.

� If you are running ReachOut on a Wide Area Network (WAN) and
there are bridges or routers that must be traversed to make the
connection, then they must let the ReachOut packet through. If they
do not, you may need to modify your Broadcast ID or key your
router to allow broadcast packets with Banyan port #0EEh to pass
through. To modify the Broadcast ID in Windows, use the
Configuration Advanced Settings. In DOS, use the “BRCST=” switch
on the RCHBANV command line. See Appendix B for information on
DOS command line switches.

If ReachOut will not connect to a listed Host:

� Someone may have connected to it since the list was generated.
Click Show List of Available Network Names to turn off the list, then
click it again to let ReachOut generate a fresh list of available Hosts.

If you can’t connect or lose connections
easily:

� Your system may have an IRQ conflict. Network cards use an IRQ in
much the same way a modem does. See the IRQ conflict section
under Modem Connections. See your system administrator if you
can’t easily resolve an IRQ conflict.
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� Your system may have a memory conflict. You have to make sure
that your Windows default EMS page does not conflict with the
memory address space of your video card or the Host's network
card. You can use the emmexclude= parameter in the [386enh]
section of SYSTEM.INI to exclude any areas already in use. Use the
same values that appear on a 386 memory manager line in
CONFIG.SYS. The Microsoft files SYSINI3.TXT and NETWORKS.TXT
in your Windows directory provide guidelines for loading
networking software. Your network administrator may be able to
help. Adding Emmexclude=A000-FFFF in the [386Enh] section of
SYSTEM.INI, is a quick way of determining upper memory
problems.

If Remote Control functions very slowly:

� If you are using Novell’s SAP configuration, you need to be running
in a network shell.

� If you are using an older version of Banyan VINES, try enabling disk
caching. In the ReachOut Viewer, choose Viewer Options from the
Preferences menu and check Enable Cache.

� Remote Control can be sluggish when you are performing ReachOut
NetBIOS communications in the NETBEUI environment of LAN
Manager. Because of the NetBIOS packet size ReachOut uses,
NETBEUI inserts 0.1-second delays between transmitted packets. To
fix this problem, insert the following line under the [NETBEUI_XIF]
in LAN Manager’s PROTOCOL.INI file:

PIGGYBACKACKS=0

This should be done for every Host and Viewer PC running LAN
Manager.
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Modem Pool Troubleshooting

Software that lets you share modems generally includes special drivers
that control it. Some modem pool software also includes a program that
lets you monitor connections.

When you configure ReachOut to use a modem pool, be sure and
choose an entry that is compatible with the one you will use. For
example, the US Robotics Shared Access LAN  modem uses a MASI
interface, which is compatible with the NASI/NCSI modem pool available
in the list. You must load the MASI TSR before starting Windows and
using a modem from the pool. ReachOut help includes additional
information about modem pools.

See your Modem Pool software documentation or administrator for help
with problems. If your problems are with a modem used by the modem
pool, check the Modem Troubleshooting section earlier in this
Appendix.

Mouse Troubleshooting

For a DOS Viewer mouse to be active on a connected Host, a DOS driver
must be loaded before DOS Viewer (VIEW) is loaded.

A Windows Viewer mouse is active while remote controlling a Windows
Host. If you want a mouse to be active while you control the connected
system in DOS, you’ll have to load a mouse driver in DOS on both Host
and Viewer computers before starting ReachOut.

Occasionally, the DOS Viewer’s mouse in the viewing window moves
easier in one direction than the opposite direction, or extremely slow
movement of the Viewer’s mouse in one direction doesn’t move the
mouse at all. In either case, you can add a parameter to the command
that loads the mouse on the Viewer.
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The Microsoft DOS mouse driver is usually loaded on the Viewer in the
CONFIG.SYS or AUTOEXEC.BAT file. (If you have the option, MOUSE.SYS
is a bit more reliable than MOUSE.COM.) The line usually says:

DEVICE=C:\WINDOWS\MOUSE.SYS /Y CONFIG.SYS

C:\WINDOWS\MOUSE /Y AUTOEXEC.BAT

Use an editor such as Microsoft's DOS EDIT to add /Sn following the /Y.
Use a number between 50 and 100.

DEVICE=C:\WINDOWS\MOUSE.SYS /Y /S50 CONFIG.SYS

C:\WINDOWS\MOUSE /Y /S50 AUTOEXEC.BAT

Experiment with numbers between 50 and 100 to adjust for your
particular mouse.

If you are using a Logitech mouse, be sure to use its drivers.

Redirecting Printing

In order to redirect printing from the Host computer to the Viewer, the
ReachOut Host must allow printer redirection. You can verify this
through Host Security Options. Supervisor Security may also limit
redirection.

Note: For information on redirecting printing from a Windows 95
Host computer, see Appendix C, Windows 95.

Host:
A compatible printer driver for the Viewer’s printer must be installed on
the Host.

To tell Windows to use the Viewer printer
driver

1. On the Host PC, connect that printer to LPT1.DOS.
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 In the Windows Control Panel, select Printers. Choose

the printer driver that matches the Viewer printer. Then

click Connect.

2. In the resulting dialog box, choose LPT1.DOS. Make sure

Fast Printing Direct to Port is not checked.

3. Close the Control Panel.

4. If the Host is connected to a network, disabling the

network printer redirection during a ReachOut session

will be helpful

Viewer:
ReachOut redirects printing to a printer with the Pass Through option.
(You can install the HP LaserJet Series II driver if your printer driver
doesn’t support Pass Through.) Make the Pass Through printer the
default printer. Set it to the same printer port as the printer you will
really use. All formatting for the print will be done at the Host system, so
it doesn't matter whether the definition is correct at the Viewer.

When connected:

1. Choose the Pass Through printer.

2. Print as usual.

ReachOut for DOS

In DOS, the same printer driver is required on both Host and Viewer
systems.

Host:

1. Enable redirection through the Security menu on the

Host computer.

2. Make sure the same printer driver you will use on the

Viewer is available.
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Viewer:

1. Specify the desired redirection on the Printing menu.

2. On the Printing menu, choose Your Print Device and

specify the port.

When connected:

1. Choose the printer driver, if necessary.

2. Print as usual.

Video Resolution

If you have a muddled display, the problem may be in video resolution.
ReachOut works best when the Viewer has the same or better video
resolution than the Host.

ReachOut does not support Windows with CGA and Hercules cards.

A DOS Viewer is limited to 640x480x16 colors (VGA) or 800x600x16
colors (SuperVGA).

DOS Graphics Don’t Display

A few DOS programs depend heavily on graphics to accomplish their
work. ReachOut provides a special TSR that you can use to make DOS
Graphics programs display nicely. It takes about 10 KB extra in memory.

Add this command to GHN.BAT or GHM.BAT, depending on whether you
control DOS graphic programs over a network or with a modem:

C:\REACHOUT\DOSGRAPH

Use any text editor to insert the line immediately following the line with
RCHDOS that specifies your computer name. Use the correct path to
your ReachOut directory if you used a different drive or directory.
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System Requirements

To run ReachOut under Windows, each computer must have:

� IBM AT, PS/2, Compaq, or 100% compatible PC

� Intel 386 compatible processor or higher

� MS-DOS or PC DOS 3.1 or higher (5.0 recommended)

� Windows 3.1 or 3.11 (Enhanced Mode), or Windows 95 (if using
ReachOut in Windows)

� 7 MB of disk space for complete installation (less for custom
installation)

� 4 MB RAM (ReachOut for DOS requires only 640K)

� VGA or SVGA display, up to 2048 x 1280 resolution, 256 colors
(ReachOut for DOS requires CGA, EGA Hercules, monochrome, or
MCGA display; supports up to 800 x 600 resolution, 16 colors)

You also need at least one of the following:

� Modem: Hayes AT Compatible 2400 bps (9600 bps or higher
recommended), High Speed V.34

� Network: Novell NetWare IPX/SPX, Banyan VINES, Artisoft Lantastic
or any 100% compatible NetBIOS, FTP’s TCP/IP, or WinSock TCP/IP

� Null modem serial cable

Optional:

� ISDN (either modem or network access)

� Internet access

� Remote Node software

� For gateways: NetWare Connect, Telebit ACS, NASI/NCSI, Modem
Assist, INT 14/6B, or Shiva ACS
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After Installation

ReachOut adds files to your computer and changes to your system when
you install. This section contains information about those changes.

Files You May Want to Use

During the installation process, files are copied to your hard disk in the
REACHOUT directory (or whatever directory you specified). The table
below lists and describes specific files you may need or want to access.
Note that many ReachOut files have two versions, one for when you are
using ReachOut in Windows, and the other for when you are using
ReachOut in DOS; the latter have a “D” at the end of the file name.

File Description

VIEW.BAT Starts the DOS Viewer for the current connection
type. For more information, see Chapter 3, Getting
Connected.

GVM.BAT Starts the DOS Viewer for a modem connection.

GVN.BAT Starts the DOS Viewer for a network connection.

HOST.BAT Starts the DOS Host for the current connection type.
For more information, see Chapter 3, Getting
Connected.

GHM.BAT Starts the DOS Host, configured for a modem
connection.

GHN.BAT Starts the DOS Host for a network connection.

UNLOADMH.BAT Unloads the Modem Host TSR.

UNLOADNH.BAT Unloads the Network Host TSR.

CONFIG.BAT Configures ReachOut under DOS.

Batch Files
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VIEWMENU.EXE Runs the ReachOut Viewer for Windows (ReachOut
Viewer icon).

HOSTMENU.EXE Runs the ReachOut Host for Windows (ReachOut
Host icon).

SETUP.EXE Configures ReachOut (Configuration icon).

RCHSCRPT.EXE Opens the Scripting window (Automating icon).

SECURITY.EXE Runs Supervisor Security (Supervisor Security
icon).

REMOVE.EXE Removes ReachOut from your computer (Uninstall
icon).

AUDIT.EXE Opens the ReachOut Audit Log.

FILEMAN.EXE Starts ReachOut File Manager.

MODEMCFG.EXE Opens the ReachOut Modem Editor so you can
define or edit the modem ReachOut uses.

PASSWORD.EXE Opens the ReachOut Password List.

RAMAP.EXE Runs Map Drives.

RCHMDIAG.EXE Opens the Modem Diagnostics window.

RCHTERM.EXE Run the ReachOut Terminal Emulator.

SERVEUP.EXE Runs Share Drives.

VIEWER.EXE Opens the ReachOut viewing window for viewing
and controlling a Host.

INSTALL.EXE Installs ReachOut under Windows.

INSTALLD.EXE Installs ReachOut under DOS.

SETPATH.EXE In DOS, sets the path where ReachOut looks for
executable files.

Executables
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PHONEBK.EXE Opens the ReachOut for DOS Phone Book.

DISC.EXE In DOS, disconnects a Host from a Viewer.

VDISC.EXE In DOS, disconnects a Viewer from a Host. For use
with Drive Mapping Automation; contact Stac Fax or
the Stac BBS for a technical note.

DOSGRAPH.EXE Allows DOS graphics to be viewed over the
ReachOut link.

HOSTMDM.EXE On the Host computer, lets you access the DOS
Modem Host.

HOSTNET.EXE On the Host computer, lets you access the DOS
Network Host.

RACLIENT.EXE Configures the computer as a ReachOut Drive
Mapping Client. This means the computer can
access mapped drives.

RASERVER.EXE Configures the computer as a ReachOut Drive
Mapping Server. This means the computer can
make its drives available to a connected computer.

RCHACS.EXE Configures ReachOut to use a modem pool
connection.

RCHBANV.EXE Configures ReachOut to use a Banyan VINES
network connection.

RCHDOS.EXE Starts ReachOut for DOS.

RCHFILE.EXE Allows background file transfer while you perform
other operations.

RCHFTP.EXE Configures ReachOut to use an FTP TCP/IP network
connection.

RCHNETB.EXE Configures ReachOut to use a NetBIOS network
connection.

DOS TSRs
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RCHSPX.EXE Configures ReachOut to use a NetWare network
connection.

RCHSRL.EXE Configures ReachOut to use a modem connection.

RCHWS.EXE Configures ReachOut to use a Windows Sockets
network connection.

VIEWMDM.EXE Opens the ReachOut Modem Viewer for DOS.

VIEWNET.EXE Opens the ReachOut Network Viewer for DOS.

VWREXEC.EXE Enables the ReachOut for DOS Viewer. This file
automatically loads when you run GVM.BAT or
GVN.BAT.

MTABLE.RCH Contains the list of modem configurations you can
use with ReachOut. You can add modem definitions
to this list, and you can download an updated
default list from the Stac BBS. See the Windows
online help for more information.

README.TXT Includes last minute information that didn’t make it
in the manual at the time of printing.

RO_HELP.HLP ReachOut Help for Windows. (Help icon).

ROINFO.EXE Displays technical information about ReachOut in
Windows.

ROVER.EXE Displays version numbers for the ReachOut files.

ReachOut also places the ReachOut Windows information file,
REACHOUT.INI, into your Windows directory. For technical notes on the
settings in REACHOUT.INI, contact the Stac BBS or Stac Fax.

Miscellaneous
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System Changes

If you install ReachOut under Windows, the following lines are
automatically added to the [386Enh] section of your SYSTEM.INI file
(Windows directory):

device=C:\REACHOUT\vrchsys.386 ; added by ReachOut

device=C:\REACHOUT\vrchdos.386 ; added by ReachOut

device=C:\REACHOUT\raclient.386 ; added by ReachOut

And if ReachOut is configured to use a modem:

device=C:\REACHOUT\vrchsrl.386 ; added by ReachOut

These lines tell Windows to load special drivers needed by ReachOut to
run in Windows.

If you uninstall ReachOut, the lines are removed from SYSTEM.INI.

Installation Script Keyword Reference

Following is a complete list of the installation scripting keywords
available in ReachOut. Unless you are a network administrator, you will
probably not need to use this information. See Chapter 9, Network
Operation, for related network information.

You can use the underlined part of a keyname or parameter as an
abbreviation for the word itself. Install prompts the user for any values
you do not set.

Keyname Parameters Description

AUTO —— Performs installation
without prompts.

AUTOSTARTHOST= yes
no

Determines if ReachOut
Host is added to the StartUp
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group.

COMM= ACS
Direct
Modem
Network

Sets the connection type.

COMPANYNAME= company Sets the company name for
licensing information.

EXECUTE= file_name After install, exits Windows,
runs the named program,
and restarts Windows.

EXITWINDOWS —— After install, exits Windows.

FILE= no
1, 2, 4, 8

Sets the size of the file
transfer buffer (in K) for
ReachOut File Manager.

GRAPHICS= yes
no

Determines if DOS graphics
are supported
(default=no).

GROUP= name Sets the name of the
Program Manager group.

HIDDEN —— Suppresses all the
installation screens.

ICONS= program,desc.;
...;program,desc.

Puts icons in the ReachOut
group.

INT= hex_integer Sets the FTP TCP/IP
interrupt vector.

MODE= Windows
DOS
Both

Sets the operating system
ReachOut is used in.
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NAME= computer
%1

Sets the network computer
name. (Leave blank by
typing NAME=. If blank on
Novell networks, ReachOut
uses the Novell logon
name.)

NETWORK= Banyan
FTP
IPX
NetBIOS
SAP
SPX
WinSock

Sets the network type.

NOCOMM —— Skips asking for COM port.

NOGROUP —— Does not create a Program
manager group.

NOMODEM —— Skips modem
configuration.

NOPASSWORD —— Skips asking for password.

NOSETUP —— Skips the setup part of
install and just copies files
(DOS only).

PUBLIC —— Installs only data files.

RACLIENT —— Configures as a Drive
Mapping Client.

RANONE —— Does not set up Drive
Mapping.

RASERVER —— Configures as a Drive
Mapping Server.
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REM statements Indicates comments.

RESTARTWINDOWS —— After install, restarts
Windows.

SERVER= server Sets the NetWare server
name.

SOURCE= path Sets directory installed from
(DOS only).

TARGET= path
path\%1

Sets directory installed to.

TYPE= Host
Viewer
Both

Sets Remote Control
function.

USERNAME= name Sets the user name for
licensing information.

WINDOWSSERVER Configures the computer to
be a ReachOut Drive
Mapping Server.

Note: There is a limit to the length of each text line in an
installation script. ReachOut ignores anything after the first 200
characters on a line. For most installation keywords, this is not a
problem, but it limits the number of icons you can place in the
ReachOut group with the ICONS= keyword.

DOS Information

ReachOut automatically creates batch files that you run to start the DOS
Host or Viewer. The contents of these batch files depend on the
configuration options currently in effect. You should be able to change
to the ReachOut directory and type HOST or VIEW to start ReachOut.
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HOST.BAT and VIEW.BAT call the specific batch files needed to
communicate either with a modem or over a network. These batch files
are:

� GHM.BAT (Host Modem)

� GVM.BAT (Viewer Modem)

� GHN.BAT (Host Network)

� GVN.BAT (Viewer Network)

The first command each batch file carries out is to set the rchpath
environment variable; it indicates the directory in which ReachOut is
stored. If you rename the directory or move ReachOut to another
directory, you may have to edit the batch files to reflect this change.

You can use the batch files UNLOADMH.BAT or UNLOADNH.BAT
(depending on whether you are using a modem or a network) to
remove the ReachOut Host from memory.

ReachOut TSRs

Each ReachOut batch file loads TSRs (Terminate-and-Stay-Resident
programs) that ReachOut needs to function in DOS:

� The communications module (RCHSRL, RCHACS, RCHBANV,
RCHFTP, RCHNETB, RCHSPX, or RCHWS)

� RCHDOS

RCHSRL.EXE is the communications program for using ReachOut over a
modem; RCHACS is for modem pools. The other communication TSRs
are for the various network protocols. The communications TSR must
be loaded before RCHDOS.

The ReachOut Viewer loads VWREXEC, which provides the viewing
capabilities for ReachOut.
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Five optional TSRs provide further capabilities for ReachOut:

� HOSTMDM or HOSTNET: On the Host computer, lets you access the
DOS Host.

� DOSGRAPH: Allows DOS graphics to be viewed over the ReachOut
link. If you don’t load this TSR and you try to view a graphics
application, ReachOut displays a message indicating that the Host is
running a graphics application. To clear the message, exit the Host
application.

� RCHFILE: Allows background file transfer while you perform other
operations.

� RACLIENT: Configures the computer as a ReachOut Drive Mapping
Client. This means the computer can access mapped drives.

� RASERVER: Configures the computer as a ReachOut Drive Mapping
Server. This means the computer can make its drives available to a
connected computer.

You must unload TSRs in reverse order. On the Viewer computer,
ReachOut does this automatically when you exit the Viewer. On the Host,
run UNLOADMH.BAT or UNLOADNH.BAT.

To manually unload a TSR

• Type the TSR name along with the UNLOAD switch and

press ENTER. For example, to unload RASERVER.EXE,

change to the ReachOut directory and type:

 RASERVER UNLOAD

Avoiding TSR Conflicts

When using network communications, avoid loading other TSRs after
loading network software and before loading ReachOut. This could
cause problems with ReachOut File Manager.
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Check that the hot keys used by ReachOut do not interfere with the hot
keys used by other programs you may be running. The default key
combinations for displaying ReachOut are:

� ALT+RIGHTSHIFT (ReachOut Host)

� LEFTSHIFT+RIGHTSHIFT (ReachOut Viewer)

ReachOut Viewer

You need at least 1 MB of free disk space to run the DOS Viewer.

You can connect to a Host running Windows even if the Viewer computer
does not have Windows. You can run the DOS Viewer from within
Windows, but you should not change the Viewer’s .PIF file.

Highlight any menu or menu item and press F1 to get help in the
ReachOut Host or the ReachOut Viewer.

Command Files

ReachOut command files allow you to automate functions upon making
a DOS-to-DOS connection to a Host. A command file is a text file
containing a list of keystroke commands that are placed directly into the
Host’s keyboard buffer. This is useful for automating a network logon, or
running a batch file. You create a command file on the Host computer,
then attach the file to a password so that it executes when the user
connects with that password.

To create a command file

1. Using any text editor (such as DOS EDIT), create a new

file.

2. Type in order the DOS commands you want to run when

a connection is made.

 Type each command on a new line.
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3. Save the file to the ReachOut directory with a file name

that uses the extension .CMD.

You can create as many command files as you want, and attach each to a
different password.

To attach a command file to a password

1. Change to the ReachOut directory.

2. Type PASSWORD and press ENTER to open the ReachOut

Password List.

3. Edit an existing password entry, or create a new one.

4. In the Command File field, type the name of the

command file to use with this password. Do not type the

extension “.CMD.” For example, if you saved your

command file as TEST.CMD, type TEST in the Command

File field.

Your command file can consist of any commands you normally type at
the DOS prompt. Refer to the MS-DOS documentation for help on these
commands.

In addition, you can use batch file programming within a command file.
Here is an example of a command file that changes to the directory
C:\USER1. If the directory does not exist, the command file creates it.

IF NOT EXIST C:\USER1\NUL MD C:\USER1

CD C:\USER1

You can also use ReachOut commands and variables in the command
file. For a list of ReachOut command line switches, see Command Line
Switches later in this Appendix.

For another example of a command file, see ReachOut Gateways in
Chapter 9.
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Command Line Switches

ReachOut’s DOS executables (*.EXE) support a number of command
line switches. Some of these switches let you configure ReachOut directly
at the DOS prompt; others provide ways to pass variables to the
executable.

The DOS executables that support command line switches are grouped
below according to their functions.

Note: For Windows command line switches, see ReachOut Help.

Installation and Setup

The following switches apply to the file INSTALLD.EXE.

Switch Description

CONFIGURE Runs the configuration part of install.

PUBLIC Installs only data files and batch files. (ReachOut
must be installed in the source directory. The
target directory must be unique for each user.)

Communications Modules
The communications modules are the files that configure ReachOut for
various connection types; they are RCHACS, RCHBANV, RCHFTP,
RCHNETB, RCHSPX, RCHSRL, and RCHWS. The following switches apply
to all communications modules.

Switch Description

APIINT=integer Changes the API interrupt value from standard
mode (Windows).

KBD=file Sets an alternate Windows keyboard intercept file.

NAME=computer Sets the ReachOut computer name.

INSTALLD

All
Communications

Modules
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NO386 Does not load Windows 386 drivers.

NOHOST Does not load Windows Host support.

UNLOAD Unloads the communications TSR from memory.

The following switches apply to all of the network communications
modules—the files RCHBANV.EXE, RCHFTP.EXE, RCHNETB.EXE,
RCHSPX.EXE, and RCHWS.EXE.

Switch Description

INGTMO=integer Number of seconds ReachOut searches for
network Hosts.

PROMPT Prompts for computer name when you start the
Host or Viewer.

The following switches apply to RCHBANV.EXE and RCHSPX.EXE.

Switch Description

BRCST=ID Sets a six-character broadcast ID.

GROUP=ID Sets a six-character group ID.

The following switch applies to the file RCHBANV.EXE.

Switch Description

HOP=integer Sets the number of networks to hop for broadcast
communications.

The following switch applies to the file RCHFTP.EXE.

Switch Description

TCPINT=
hex_integer

Sets the TCP Interrupt vector (default is 61h).

RCHBANV
RCHFTP

RCHNETB
RCHSPX
RCHWS

RCHBANV
RCHSPX

RCHBANV

RCHFTP
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The following switches apply to the file RCHNETB.EXE.

Switch Description

LANA=integer Sets the LAN adapter to use, if the PC has more
than one (range: 0–9).

NAMETYPE=
integer

Sets the last character of the 16-character
NetBIOS name (range: 0–255; default is 15).

The following switches apply to the file RCHSPX.EXE.

Switch Description

COMPAT Ignores router information, sending a broadcast
packet only.

NOWATCH Disables watchdog timer.

OPNTMO=integer Sets the number of seconds to wait for an IPX
connection.

SERVER=server Sets the NetWare server name.

SAP Configures ReachOut to use the NetWare Service
Advertising Protocol (SAP).

The following switches apply to the modem communications module—
the file RCHSRL.EXE.

Switch Description

AUTOBAUD Lets ReachOut automatically determine the
maximum transmission speed.

CTSTMO=integer Sets the number of seconds for CTS to go high
before transmitting data (default is 10).

DEBUG Allows connections without error correction.

RCHNETB

RCHSPX

RCHSRL
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HIRELY Disables ACK/NAK of packets, so any bad packet
terminates the link.

IGNORECARRIER Forces ReachOut to ignore carrier detect signal.

NOCOMPRESS Turns off communications level compression.

OBEYCARIER Forces ReachOut to use the carrier detect signal
to determine if connected modems are ready.

OLDNASI Uses old NASI method to get connection status.

RCVTRIG=integer Sets the rcv FIF trigger for a buffered UART
(range: 0–3, for FIFO 1, 4, 8, or 14; default is 2,
for receiving FIFO at 8).

UART=integer Sets UART type (0-8250 or 8250-B, 1-8250A or
16450, 2-16550, 3-16550A, 4-82510, 5-auto).

DOS Connections

The following switches apply to the file DOSGRAPH.EXE.

Switch Description

COLOR Tells ReachOut to display graphics using the Host
computer’s color palette, so you view the screen
as it appears on the Host. Use this if you have
DOS applications that alter the default palette.

UNLOAD Unloads the DOS graphics TSR from memory.

The following switches apply to the file RCHDOS.EXE.

Switch Description

COLDBOOT Sets reboot to do a full memory test.

HARDBOOT Sets hard reboot.

DOSGRAPH

RCHDOS
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SOFTBOOT Sets reboot similar to pressing CTRL+ALT+DEL.

WARMBOOT Sets reboot without memory test.

DOSBUF=integer Sets the DOS communications buffer size, in
kilobytes.

DOSFLUSH=
integer

Sets the number of 1/18-second intervals to wait
before flushing a partial DOS command buffer to
the Viewer (default: 1).

DOSIGNORE Sets a six-second timeout before connecting.

DSPSIZE=integer Sets the number of text characters to be
displayed.

I09ENTRY=
integer

Sets the level of checking to be done before
forcing a scan code into the software INT 09h of
the Host computer. Valid settings are 2, 3, 4, and
5; I09ENTRY=4 works best.

I10ASYNC=
integer

If 0, INT 10H BIOS commands are immediately
intercepted and reflected to the Viewer. If 1,
ReachOut allows the screen to be updated
asynchronously over 1/18-second intervals to
redirect Int10h commands to a Viewer, such as
25th line messages.

INACTIVEDISPLAY Makes display packets reset the inactivity timeout.

INT1A=integer If 0, INT 1ah is not intercepted (default: 0).

KYBFEED=integer If 0, emulates keyboard codes back to back into
the Host; otherwise, emulates at 1/18-second
intervals.

KYBMSK Disables Host keyboard input.
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NOGRAPH Suppresses message when DOS graphics cannot
be displayed.

NOLISTEN Ignores Auto Connect.

NOMOUSE Disables the DOS mouse.

PHONYLPTS=
integer

Defines fake LPT ports for the Host to allow
redirected printing if the Host has no LPT ports.

RBTTMO=integer Sets the number of seconds to wait for an
“Immediate” reboot after disconnection
(default: 5).

SHOWPARAMS Displays internal variable settings.

SSCOUNT=integer Sets the maximum number of single-step
instructions to execute after IN AL,60h is
encountered in extended keyboard handling
(default: 250).

UNLOAD Unloads the DOS TSR from memory.

VIDEO=integer Sets the Host video device (0-Mono, 1-Hercules,
2-CGA, 3-Comp CGA, 4-EGA, 5-VGA, 6-MCGA).

ReachOut Host and Viewer

The following switches apply to HOSTMDM.EXE and HOSTNET.EXE.

Switch Description

NOCHARSET Ignores saving the video text characters when you
display the DOS Host.

NOHOTKEY Disables hot key display of Host.

MONO Sets Host display to Mono.

PROMPTLINK Prompts for a Viewer to connect to when you
display the Host.

HOSTMDM
HOSTNET
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UNLOAD Unloads the ReachOut Host from memory.

The following switches apply to VIEWMDM.EXE and VIEWNET.EXE.

Switch Description

/ALTPOP=1 Changes the hot key for displaying the Viewer to
LEFTCTRL+RIGHTSHIFT.

/CACHE=0 Disables 512K disk cache.

/LIST=0 Disables connection using network list.

/NAME=
computer

/NAME=%1

Automatically connects to the computer name
specified. Use %1 in a batch file to pass the
command line name to the executable.

/PHONEBOOK=
“username”

/PHONEBOOK=
“%1”

Automatically connects to the Host in the phone
book with the username specified. Use %1 in a
batch file to allow you to pass the username to
the executable.

/SVGAMODE=
<rax>, <rbx>

Sets values if you cannot view SuperVGA. Look in
SYSTEM.INI or your video card manual.

File Transfer

The following switches apply to the file RCHFILED.EXE.

Switch Description

BUFFER_SIZE=
integerK

Sets the size of the buffer for background file
transfer.

UNLOAD Unloads the file transfer TSR from memory.

VIEWMDM
VIEWNET

RCHFILED
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Drive Mapping

The following switches apply to the Drive Mapping configuration files—
RACLIENT.EXE and RASERVER.EXE.

Switch Description

BUFFER_SIZE=
integerK

Sets the size of the buffer for transmitting data
with Drive Mapping.

UNLOAD Unloads the Drive Mapping TSR from memory.

The following switches apply only to the file RACLIENT.EXE.

Switch Description

EXEC Allows programs to be run from a mapped drive.

SEARCH_AHEAD=
integer

Sets the number of directory entries that are pre-
read (default: 23).

RACLIENT
RASERVER

RACLIENT
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WINDOWS 95C
ReachOut for Windows & DOS has been optimized to take advantage of
many Windows 95 features—including long file names and all Windows
95 video drivers. If you are using ReachOut for Windows & DOS under
Windows 95, you can:

� Use Telephony with ReachOut, so that ReachOut works more
smoothly with your other modem, FAX, and telephone applications

� Use your Windows 95 modem setup information for ReachOut

� Preserve long file names when using ReachOut to transfer files
between Windows 95 computers

� Redirect printing from a Windows 95 Host.

The following pages describe these features and how you can take
advantage of them if you are using ReachOut for Windows & DOS under
Windows 95.

Getting Started

To install ReachOut, follow the instructions in Chapter 2 of this part of
the ReachOut User’s Guide. The Windows 95 Run command is located
on the Start menu. The name of the directory to which you install
ReachOut must have eight or fewer characters.

To start ReachOut

1. From the Windows 95 Start menu, choose Programs.

2. Click ReachOut.

3. Choose ReachOut Host if you want your computer to be

a Host, or choose ReachOut Viewer if you want to

remotely control another computer.
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Modem Connections

Windows 95 comes with Microsoft’s Telephony Application
Programming Interface (TAPI). ReachOut now lets you take advantage of
this Telephony feature to organize your incoming calls. If you have
already set up a modem on your Windows 95 computer, ReachOut can
use your existing configuration; you don’t have to configure the modem
again in ReachOut.

If you choose not to use Telephony with ReachOut, you can still use
ReachOut’s Configuration settings to set up your modem. See Turning
Off the Telephony Option later in this appendix.

What is Telephony?

The Telephony feature acts like a manager for all your incoming calls.
For example, suppose you have a FAX program and a bulletin board
system (BBS) that use the same communications port. When you receive
a call, TAPI determines if the incoming call is a FAX or a BBS call and
sends it to the appropriate software. That way you are less likely to have
problems such as your FAX software trying to answer a BBS call, and vice
versa. You can leave both applications running, and calls are
automatically sent to the correct application.

The only requirement is that all your communications programs be able
to register themselves with TAPI. Some programs may do this
automatically. Once you’ve configured your various programs to use
Telephony, it will handle all your calls.

Activating Telephony in ReachOut

Registering ReachOut with Telephony tells Windows 95 to track
ReachOut calls along with your other calls. All you have to do is
configure your modem with the Telephony option.
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To turn on Telephony

1. From the Windows 95 Start menu, choose Programs.

2. Click ReachOut, then Configuration.

3. Choose Modem, then click OK.

 You’ll see the ReachOut Configuration window.

 

4. Click the Telephony check box.

 You should notice several changes:

• The Modem Properties button becomes available.

• The Port and Baud fields become unavailable. You

can set these options through the Modem Properties

dialog box.

• The selected modem may change, depending on

which modems are already set up in Windows 95.

The names of the modems may also change slightly

to match the Windows 95 names for these modems.

5. If you use more than one modem, you can choose which

one to use with ReachOut by clicking the Modem drop-

down list box.
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6. To configure your modem, click Modem Properties.

 If you’ve never set up a modem on your computer, you’ll

be guided through the process. Then when you return to

the ReachOut Configuration dialog box, you’ll need to

click Telephony again to activate it.

7. When you’ve finished, click OK and exit ReachOut

Configuration.

The Modem Properties dialog box has three tabs:

General Click the General tab to specify basic properties for
your modem. You can change the communications
port your modem is using, set the volume, and specify
the speed at which your modem can connect.

Connection Click the Connection tab to change settings for your
modem connections. Windows 95 provides standard
defaults, but you might need to change these settings
when you connect to different computers. Many
systems use 8 data bits, no parity, and 1 stop bit. For
explanations of these settings, see the topic Data Bits,
Stop Bits, and Parity in ReachOut Help.

Options Click the Options tab to set miscellaneous preferences
for the current call. Use these options to dial with a
credit card, dial an operator-assisted call, or open a
terminal window before dialing.

To get help in the Modem Properties dialog box, click the question mark
in the upper right-hand corner, then click any part of the dialog box.
You’ll see a brief description of the field or button you clicked.

Defining a New Modem in Windows 95

If you use the Telephony configuration for your modem, then you won’t
be able to add a new modem directly through the ReachOut
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Configuration program. You need to use the Windows Control Panel
instead.

See Windows Help to learn how to set up a new modem.

Turning Off the Telephony Option

Although the Telephony option makes configuring a modem easier for
most Windows 95 users, there may be circumstances in which you want
to use ReachOut’s Configuration settings instead. For example, if you
have a nonstandard modem, it may not be listed in the Windows 95
modem list. ReachOut’s list contains some modems that the Windows 95
list does not. Plus, you can easily define a new modem using ReachOut’s
Modem Editor, and then set your configuration options within ReachOut.
Advanced users may also want to use the ReachOut Modem Editor to
change the modem strings.

See ReachOut Help for instructions on using the Modem Editor.

Long File Names

ReachOut File Manager supports long file names in Windows 95. The
File Manager displays Windows 95 files with their full file names. You
can preserve these file names when you copy the files between
Windows 95 computers. When you synchronize directories between a
Windows 95 computer and a Windows 3.1 computer, ReachOut ignores
any files that have long file names.

You can also copy files with long file names to computers running other
versions of Windows and DOS. ReachOut shortens the file names so that
they each have a maximum of eight characters with a three-character
extension. Before you copy a file, you can see what name ReachOut will
give the file by looking at its details.

You can get more

information on a

file by choosing

Details from the

File menu, or by

right-clicking its

name
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To View Details about a File

• In ReachOut File Manager, right-click the file name.

If the file is stored on a Windows 95 computer, you’ll see the full name
of the file as well as the MS-DOS shortened name that ReachOut assigns
to it. This dialog box also displays the creation date and the date that the
file was last accessed (opened or copied).

From within the file list, you can also get details on a directory. However,
the Details command is not available from the directory tree.

Copying and Deleting Files

If you want to use the Copy or Delete command on two or more files at
once, you can use spaces to separate the file names in the dialog box.
However, if you enter a long file name that contains a space, you need to
put quotation marks around the entire file name, like this:

Charts.xls "Spending cuts" Organization

Directory tree

File list—

right-click

any file or

directory to

view

details

The name of the

file is shown here

These details are

displayed for all

files

These details

are only

displayed for

Windows 95

files
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IMPORTANT! It’s a good idea to keep File Overwrite
Confirmation turned on. (Confirmation is on the Options menu.) If
you copy files with similar long file names to a Windows 3.1x
computer, ReachOut may overwrite one file with another. For example,
the files “John's file 1” and “John's file 2” are both truncated to
JOHN'S_F.

Redirecting Printing from a
Windows 95 Host

Windows 95 handles printers differently than Windows 3.1 does. As a
result, you can’t print to both the host and viewer from a Windows 95
Host computer.

When you install ReachOut for Windows & DOS on a Windows 95
system, the installation program creates a new port named RCHOUT.PRN
in your REACHOUT directory. Windows 95 considers this an “unknown
local port.” While connected with print redirection enabled, ReachOut
can have any printing from the remotely controlled computer occur on
the Viewer printer. You’ll have to change the Host printer back to the
standard one before you can print successfully to the Host printer.

On the Windows 95 ReachOut Host

1. On the Start menu, choose Settings, then Printers.

2. Select the printer, then right-click.

3. On the context menu, choose Properties, then click the

Details tab.

4. In the “Print to the following port” field, choose

rchout.prn.

5. Notice that the “Print to the following driver” field still

identifies the usual printer. Whatever you print is

formatted for that printer. Click OK.



Appendix C •• Windows 95

174

On the ReachOut Viewer

1. On the Viewer window, choose Viewer Options from the

Preferences Menu.

2. In the Redirection field, choose Viewer Only. Choosing

Both prints only to the Viewer as well.

3. In the Printer field, choose a printer that suppports

PASSTHRU. (If you aren’t absolutely sure your printer

supports PASSTHRU, install the HP Laserjet Series II

from your Windows disks. You don’t need this type of

printer, but assign it to a valid port.)

4. Click OK.

If your Viewer runs under Windows 95:

1. On the Start menu choose Settings and click Printers.

2. Select the printer to which print is redirected. Right-click

and choose Properties.

3. On the Details tab, click the Spool Settings button.

4. In the Spool Data Format field, make sure RAW is the

format selected.

5. Choose OK.

Note: If you’ll be redirecting print from your Windows 95 Host often,
you may want to define a second printer driver just like the one you
normally use. Leave one set for the normal driver and one for
rchout.prn. Then you can just select the ReachOut printer driver
definition to redirect printing and the normal printer for standard
printing at the Host.

If no printing occurs:

Your printer probably doesn’t support PASSTHRU. Try this:
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1. Install the HP Laserjet Series II driver to the Viewer computer from
your Windows disks.

2. Connect it to the printer port you usually use, such as LPT1.

3. Choose this printer in the Viewer Preferences.

Since ReachOut does the formatting at the Host, the document should
print just fine next time you try.

If printing occurs on a nonPostscript printer, but the document
isn’t readable

On the Host computer

1. Select the printer that’s set to the RCHOUT.PRN port and right-click.

2. From the context-menu, click Properties, then the Fonts tab.

3. Click Print True Type as graphics, then click OK.

If printing is not correct on a postscript printer, the two printers
may have incompatible drivers. Install the HP Laserjet Series II driver on
the Viewer, select it as the target printer, and try again.

Host Computers on the Network

If you plan to connect to a computer running ReachOut for Windows &
DOS under Windows 95 that’s on a network (such as your office
computer), you can use ReachOut's Reboot on Disconnect feature (in
Security Options) to have the Host computer automatically restart when
you disconnect. Then the computer will be logged off the network,
ensuring security while it is unattended.

You can put ReachOut Host in your StartUp group to have it open when
the computer restarts. However, Windows 95 prompts you to log on
each time the computer starts. You need to prevent the prompt from
appearing, or the Host won’t start, and you won’t be able to connect.
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To suppress the network logon prompt

1. From the Windows 95 Start menu, choose Settings.

2. Choose Control Panel.

3. Double-click the Network icon.

4. In the list box at the top, click the network client.

5. Choose Properties.

 Note: If the Properties button is unavailable, you probably have
Novell’s NetWare client, version 3.x. You might have to use a later
version, or remove it and add Microsoft’s NetWare client instead.

6. Clear Enable logon script processing, and click OK.

 If you have other clients, follow steps 4–6 for each one.

7. Under Primary Network Logon, choose Windows Logon.

8. Choose OK, but don’t restart your computer when asked.

9. Double-click the Passwords icon.

10. Click Change Windows Password.

11. Type your old password. (Don’t enter a new one.)

12. Choose OK, and restart your computer.

If you want to access the network while you’re connected with
ReachOut, you can reconnect to any of your network servers.

To reconnect to a network server

1. On your desktop, right-click Network Neighborhood.

2. Choose Map Network Drive.

3. Under Drive, choose the letter you want to assign the

drive to. If the drive letter is already being used, you’ll

see a network path next to it in the list.

4. Under Path, select or type the server and volume name.
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 Note: You should not choose Reconnect at logon, or the
connection will be restored when your computer restarts.

5. IMPORTANT! When prompted to enter a password, clear the
check box that’s labeled Save this password in your password list.

Gateways

ReachOut gateways let you use a modem to connect to a computer
running on a network, or to connect computers that are running on two
different types of networks. To set up a gateway, you need to have a
bridge computer, which passes information between ReachOut’s modem
Host and network Viewer. ReachOut gateways are explained in detail in
Chapter 9, Network Operation.

You can connect Windows 95 computers through a ReachOut gateway,
but the bridge computer must be running MS-DOS.
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A
ACS

configuration, 86–87
connection, 78
settings, 87
troubleshooting, 141

Active window
File Manager, 54

Adding
password, 94
phone book entry, 38

ASCII documents, 9
Auditing, 47–48

across a gateway, 115
security, 112
under DOS, 48

Autobaud
modem, 83

AUTOMATE.WRI, 9, 31
Automatic

Host when you start Windows, 21
Automating

file transfers on mapped drives,
73

Icon for scripting, 16
ReachOut, 9, 31

B
Banyan VINES, 85

technical note, 122
Batch files, 147

DOS, 154–55
Baud

changing setting, 81
BBS

in phone book, 38
Bridge computer, 115–21

as Host, 116
as Viewer, 117
automatically call Host, 118
disconnecting, 121
inactivity timeout, 121
setting up, 116–20

Broadcast ID, 121
troubleshooting, 138

Buttons
Host, 22
Viewer, 24

C
Cables

troubleshooting, 128

These page numbers will be correct when you print the document. To use them online, adding 8 to the index number gives you the referenced Acrobat page.
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Callbacks
in connection, 26
password, 98
prompt, 99
security, 98
supervisor security, 111

CAPI, 89
Carrier signal

in DOS, 128
troubleshooting, 128

Changing
active window in File Manager, 54
connection type, 79
drive map path, 75
Host settings remotely, 100
Host settings remotely in DOS,

101
mapped drive letters, 72
phone book entry, 39
ReachOut function, 28
your password, 96

Chat button
Host, 22
Viewer, 24

Chatting, 50
Choosing

connection type, 79
different network, 105

Client
changing drive letters, 72
for Drive Mapping, 66

Clipboard
remote, 44–45

Cloning directory, 58, 59
COM port

identifying, 130
Command files, 157–58

for gateway, 118

Command line switches, 159–66
Commands

for installation script, 107, 151–
54

Complete installation, 14
Compression

in File Manager, 55
modem, 83

Computer name
changing, 82
configuring, 81

CONFIG
for DOS Configuration, 80

Configuration
icon, 16
modem, 168–71

Configuring
ACS, 86–87
direct connect, 87–88
ISDN line, 88–89
modem, 80–83
modem pool, 86–87
network, 84–85

Confirmation
in File Manager, 55, 173
password, 96
password in DOS, 98

Conflict
IRQ, 131
memory, 140
TSR, 156

Connect button
Host, 22
Viewer, 24

Connect Only, 73
Connecting

for Drive Mapping only, 73
in Windows, 20, 26
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under DOS, 20, 27
Connection

choosing type, 79
losing, 135
tracking, 47–48

Connection types
configuring, 81

Copying
in File Manager, 55

Creating
command file, 157
connection icons, 40
installation script, 107
master password, 100
new program group, 81
password, 94
phone book entry, 38

CTS/RTS flow
Troubleshooting, 135

Custom installation, 14

D
Data and voice, 49
Data files

installing only, 106
Defining

generic modem, 129
master password, 100
new modem, 83
password, 94

Deleting
in File Manager, 55
phone book entry, 39

Description
phone book, 39

Details, file, 172
Dialing, pulse, 83
Direct connect

configuration, 87–88
connection, 78
preparing for ReachOut

installation, 12
troubleshooting, 137–38

Directory
changing in File Manager, 54
cloning, 58, 59
limiting access in File Manager,

63
synchronizing, 58–60

Directory Tree
in File Manager, 60

Disconnect
in DOS, 29

Disconnect button
Host, 22
Viewer, 25

Disconnecting, 29
bridge computer, 121

Display
File Manager, 60
preventing, 46, 47

DOS, 89
accessing mapped drives, 73
advanced Windows options, 90
batch files, 17, 147, 154–55
changing configuration, 90
changing Host settings remotely,

101
changing mapped drive letters,

72
changing modem settings, 82
changing settings from Windows,

89
DOS (continued)

Chat, 51
choosing a different network, 106
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command line switches, 159–66
connecting in, 27
disconnecting, 29
Drive Mapping from Windows, 90
Drive Mapping setup, 69
File Manager security, 64
gateway, 116
getting help, 157
HOST command, 17
installing ReachOut, 15
mouse usage under, 17
password, 94
password confirmation, 98
phone book, 40
print redirection, 44
print redirection troubleshooting,

143
Server, 70
share drives, 70
starting Configuration, 80
starting File Manager, 54
starting Host, 23
starting Viewer, 25
troubleshooting. See topic of

concern
TSRs, 149, 155–57
unloading ReachOut, 17
using mapped drives, 73
VIEW command, 17
Viewer problems, 157
viewing display, 35

DOS graphics
from Windows, 90
troubleshooting, 144

Drive
changing in File Manager, 54

Drive Mapping

changing drive letters, 72
Client, 66
connecting for, 72
definition, 5
DOS drive letters, 72
example, 66
file, 71
overview, 65
security, 74–75
Server, 66
setting up, 69–72
setup under DOS, 69
sharing drives, 69
using, 72–73

Drive Mapping file, 71
attaching to password, 71

E
Edit Passwords button, Host, 22
Editing

password list, 94
phone book entry, 39

Emmexclude, 140
Enable

Drive Mapping, 69
Entry

phone book, 38
Example

AUTOEXEC.BAT for bridge, 120
bridge menu, 119
Drive Mapping, 66

Example (continued)
gateway, 115
limiting specific File Manager

access, 63
Executable

ReachOut files, 148
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Executing
installation script, 108

Exit button
Host, 22
Viewer, 24

F
File

command, 157–58
copy, 55, 172–73
delete, 55, 172
details, 172
Drive Mapping, 71
in File Manager, 55
in Windows 95, 171–73
list, 147–50
print to, 42
properties, 172
rename, 55
spool, 43
tagging, 56–58

File list
in File Manager, 60, 172

File Manager
active window, 54
compression, 55
direction of transfer, 54
directory cloning, 58
directory synchronizing, 58
display, 60
full access, 62
in Windows 95, 171–73

File Manager (continued)
limiting access, 62
log, 60
partial transfers, 56
ReachOut, 54
Read Only access, 62

Read/Write access, 62
security, 61–64
security under DOS, 64
SmartSend, 56
switch active window, 54
synchronization, 58
tagging, 56–58
virus checking, 55

File name, long, 171–73
File Transfer. See File Manager

button, 24
FILEMAN.EXE, 41
Flow control

troubleshooting, 135
FTP TCP/IP, 85
Full access

File Manager, 62

G
Gateway

auditing, 115
command file, 118
restrictions, 115, 177

Gateways, 115–21, 177
Generic modem

defining, 129
Graphics

troubleshooting DOS, 144
Group ID, 122

troubleshooting, 138
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H
Help, 9

contents, 16
in DOS, 157

Help button
Host, 22
Viewer, 25

Host
bridge computer as, 116
buttons, 22
Chat, 50
command under DOS, 17
definition, 5
disable in Windows, 81
icon, 16
in StartUp group, 81, 175
in Windows 95, 173–77
list for network connection, 40
minimize on startup, 50
on a network, 173–77
Security, 92
starting under DOS, 23
starting under Windows, 21

Hot key
Host, 28–29
panning, 36
Viewer, 28–29

Hunt telephone group, 116

I
Icon

Automating, 16
Configuration, 16
creating connection, 40
for immediate connection, 40
for Password List, 95
Help, 16

Icon (continued)
Host, 16
Security, 16
Support, 16
Uninstall, 16
Viewer, 16

Identifying
COM port, 130
modem, 128

Inactivity timeout, 49
Input

preventing, 46, 47
Install script, 106–8, 151–54

using, 108
INSTALL.EXE, 13
Installing

over the network, 106
preparing for, 12
ReachOut for DOS, 15
standard, 12–15
type, 14
with a script, 106–8

Int 14/6B, 87
Internet

configuring for use, 85
connection, 78, 85
requirements, 104

Interrupt request
conflicts, 131
nonstandard, 131

Intruder Guard, 112
IRQ

conflicts, 131
nonstandard, 131
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ISDN
CAPI protocol, 89
configuration, 88–89
configuring in DOS, 89
connection, 78
terminal adapter, 89

K
Keynames

for installation script, 151–54

L
LASTDRIVE, 72
Limiting

File Manager access, 62
List request timeout

troubleshooting, 138
Local, 5
Log

audit trail, 47
File Manager, 60

Logon prompt
Windows 95, 176

Long file names, 171–73
LPT1.DOS, 43

M
Map Drives button

Host, 22
Viewer, 24

Mapped drives
changing drive letters, 72

Mapping drives
connecting for, 72
DOS setup, 69
overview, 65
security, 74–75

Mapping drives (continued)
setting up, 69–72
sharing drives, 69
using, 72–73

Master password, 99
creating, 100
for Configuration, 80

Maximize
viewing window, 35

Memory conflict
troubleshooting, 140

Minimize
Host on startup, 50

Modem
changing settings, 81
changing settings in DOS, 82
changing settings in Windows 95,

170
choosing a new, 82, 169
configuration, 80–83, 168–71
connection, 78
define new, 82
generic definition, 129
identifying, 128
ISDN, 88
preparing for ReachOut

installation, 12
S7 register, 134
troubleshooting, 126–37

Modem Assist, 87
Modem diagnostics

DOS, 130
Windows, 129
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Modem pool
configuration, 86–87
connection, 78
preparing for ReachOut

installation, 12
settings, 87
troubleshooting, 141

Modem table, new, 137
Mouse

troubleshooting, 141
under DOS, 17

MTABLE.RCH, 137, 150

N
NASI/NCSI, 86
NetBIOS, 85

technical note, 123
NetWare

technical note, 122
NetWare Connect, 86
NetWare IPX/SPX, 85
Network

choosing a different, 105
configuration, 84–85
connection, 78
displaying Host list, 109
installing from, 106
list of Hosts, 40
phone book, 40
preparing for ReachOut

installation, 12
settings, 85
troubleshooting, 138–40

Network list
description, 84
timeout, 84
troubleshooting, 138

New in ReachOut, 6

New modem, 82
Novell NetWare

technical note, 122

P
Panning

hot key, 36
Partial transfers

in File Manager, 56
Pass Through printer, 43
Password, 93–100, 111

centralizing, 114
changing, 96
command file, 157
confirmation, 96, 111
defining, 94
Drive Mapping file, 71
for callback, 98
in DOS, 94
in phone book, 39
master, 99
preventing individual, 114
requirements, 94
requiring, 93

Password List
icon for, 95

PASSWORD.EXE, 95, 114
Path

adding for Drive Mapping, 75
Peer-to-peer networking

and Drive Mapping, 68
Personalizing ReachOut, 13
Phone book

adding entry, 38
managing, 37
modem, 37, 38
network, 40
under DOS, 40
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Phone line
troubleshooting, 127

Phone number
entering, 26
in phone book, 39

Port
changing setting, 81
identifying, 130

Preferences
Host, 47
Viewer, 41

Prefix
modem calls, 83

Preparation
connecting, 21
for installing, 12

Preventing
Host display from Viewer, 46
Host input from Viewer, 46
individual password files, 114
local input from Viewer, 46
print redirection, 42
through supervisor security, 113
Viewer display from Host, 47
Viewer input from Host, 47

Printing
redirecting, 41–44
redirecting from Windows 95,

173
troubleshooting, 142–44

Product support, 16
Program group, 15

creating, 81
Programs

ReachOut, 148

Prompt
for callback, 99
logon, 176

Pulse dialing, 83

R
RAMAP, 72
ReachOut

Help, 9
installing, 12–15
program files, 148
program group, 15

ReachOut files, 147–50
REACHOUT.INI, 150
REACHOUT.PRO, 63
REACHOUT.SEC, 114
Read Only access

Drive Mapping, 74
File Manager, 62

Read/Write access
Drive Mapping, 74
File Manager, 62

Redirecting printing, 41–44
from Windows 95, 173
Security, 113
troubleshooting, 142–44

Registration, 17
Remote, 5
Remote clipboard, 44–45
Remote Control

button in Viewer, 24
changing to, 28

Remote node
connection, 78

Renaming
in File Manager, 55

Requirements, network, 104
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Requirements, system, 146
Resize

viewing window, 36
Resolution, video, 20, 144
ROINST, 108

S
S7 modem register, 134
Scaling

viewing window, 36
Scripting

installation, 106–8, 151–54
to automate ReachOut, 9, 31

Security
callbacks, 98
Drive Mapping, 74–75
enforcing, 114
File Manager, 61–64, 63
File Manager under DOS, 64
Host, 92
Host computer access, 92, 177
Host utility access, 92
icon, 16
levels, 92
network, 177
passwords, 93–100
supervisor, 110–14
user names, 111

Selecting files, 56–58
Serial number, 13
Server

for Drive Mapping, 66
from DOS, 70
share drives, 69

SERVEUP.SRV, 71
SETUP

for DOS Configuration, 80

Share drives
from DOS, 70
from Windows, 69

Smart transfers
in File Manager, 56

SmartSend
in File Manager, 56

Sound
in File Manager, 55

Speed
troubleshooting, 134, 137

Spool file, 43
Starting

Configuration, 79
Configuration under DOS, 80
File Manager, 54
File Manager log, 60
in Windows 95, 167
ReachOut installation, 13, 167
Windows Host, 21, 167
Windows Viewer, 23, 167

StartUp group
Host, 21, 81

Supervisor Security, 110–14
auditing, 112
callbacks, 111
File Manager, 63
icon, 16
Intruder Guard, 112
password confirmation, 111
passwords, 111
preventing Host actions, 113
preventing print redirection, 113
preventing Viewer actions, 113
user names, 111

Support for ReachOut, 16
Switch

DOS command line, 159–66
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Switching
active window in File Manager, 54
ReachOut function, 28

Synchronizing directories, 58–60
System requirements, 146
SYSTEM.INI, 140, 151

T
Tagging

files, 56–58
matching files, 57

TCP/IP, 85
Technical support, 16
Telebit ACS, 87
Telephone

hunt group, 116
line troubleshooting, 127

Telephony
description, 168
using with ReachOut, 168–70

TERMEM.TXT, 9, 31
Terminal emulator, 30–31

documentation, 9
in phone book, 38
starting from Viewer, 24

Terminal Emulator Setup
in phone book, 39

Terminology, 5
Timeout

confirmation, 112
for gateway, 121
inactivity, 49
modem, 83
network list, 84
troubleshooting, 134
troubleshooting list request, 138

Tracking, 47–48, 112
Transfers

in File Manager, 56
Transmission speed

troubleshooting, 134
Troubleshooting

ACS, 141
cables, 128
can't list Hosts, 138
carrier signal, 128
direct connection, 137–38
DOS graphics, 144
DOS mouse, 141
flow control, 135
limited connection, 135
list request timeout, 138
lose connection, 135
memory conflict, 140
modem, 126–37
modem pool, 141
mouse, 141
network, 138–40
print redirection, 142–44
telephone line, 127
timeout, 134
transmission speed, 134, 137
UART, 134
video resolution, 144

TSR, 155–57
conflict, 156
list, 149

Type
connection, 78
installation, 14

U
UART, 82, 83

troubleshooting, 134
Uninstall ReachOut, 16
Unloading
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ReachOut, 17
TSRs, 156

Untagging, 57
User Name

defining, 94
in phone book, 39

User's Guide, 7

V
Version control

and Drive Mapping, 68
Video resolution, 20, 144
VIEW

command under DOS, 17
Viewer

bridge computer as, 117
buttons, 24
Chat, 50
definition, 5
icon, 16
preferences, 36–37, 41

Viewer (continued)
starting in Windows, 23
starting under DOS, 25
under DOS, 157

VIEWER.EXE, 41
Viewing display

under DOS, 35
Viewing window, 34–35, 34

panning, 36
scaling, 36

Vigorous
SmartSend, 56

Virus checking
in File Manager, 55

Voice and data, 49

W
Wildcards

tagging, 57
Windows 95, 167–77
Windows Sockets, 85, 104
WinSock, 85
Write Only access

Drive Mapping, 74
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